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Welcome to This Guide

This guide describes how you set up My BAC so that users can view content
such as HP Business Availability Center reports, external feeds, as well as
customized Service Reports based on data from data sources from different
applications, as portlets in their own personalized portals.

This chapter describes: On page:
How This Guide Is Organized 9

Who Should Read This Guide 10
Getting More Information 10

How This Guide Is Organized

Part |

Part Il

The guide contains the following parts:

My BAC

Describes how to define modules that can be accessed by your users through
their My BAC portal, how to import and export the portlets that are
included in the modules, how to personalize and use the My BAC portal,
and how to create and use Service Reports based on data from data sources
from different applications.

User Interface

Describes, in detail, the dialog boxes and pages used to define modules,
import and export portlets, personalize your My BAC portal, and create and
manage Service Reports.



Welcome to This Guide

Who Should Read This Guide

This guide is intended for the following users of HP Business Availability
Center:

» HP Business Availability Center administrators
» HP Business Availability Center end users

Readers of this guide should be knowledgeable about navigating and using
enterprise applications, and be familiar with HP Business Availability Center
and enterprise monitoring and management concepts.

Getting More Information
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For a complete list of all online documentation included with HP Business
Availability Center, additional online resources, information on acquiring
documentation updates, and typographical conventions used in this guide,
see the the HP Business Availability Center Deployment Guide PDF.
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My BAC

This chapter describes My BAC.

This chapter describes: On page:
Concepts

My BAC Administration Overview 14
My BAC Portal Overview 15
Java and WSRP Portlets 16
Module/Page Tree 17
Tasks

Set Up Licenses 18
Pre-Authenticated WSRP URLs 18
Import Portlets 19
Import Portlets and Modules 20
Set Up a Module 20
Personalize Your My BAC Portal 27
Export Portlets and Modules 31
Set Up CMDB Portlets 31
Use an Authenticated WSRP URL 33
Use an HTML Portlet 35
Deploy External Custom Java Portlets 36
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This chapter describes: On page:

Upgrade My BAC 42

General Reference

Types of Access 42
Portlet Categories 44
Business Process Insight Portlet 56
Welcome to My BAC Application Portlet 58
RSS Portlet 59
Default Module 59

Customization

WSRP Portlets on Solaris with an IPlanet Web Server 61
Change the Status Alert Sound 62
Troubleshooting and Limitations 62

My BAC Administration Overview

Portlets are reusable Web components that display relevant information to
portal users. Pages are collections of several portlets displayed together.
Modules are packages of preconfigured pages that display portlets.

You, the My BAC administrator, create modules, add pages and portlets to
the modules, and share the modules with selected users or security groups.
Users can only view modules, pages, and portlets to which you have given
them access rights.

14
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Portlets display information relevant to users’ business tasks, for example,
HP Business Availability Center reports, or stock market prices. HP Business
Availability Center includes portlets written and supported by HP. In
addition, My BAC administrators and advanced users at customer sites can
write their own portlets. Portlets written by industry-standard portlet
providers can be imported into the system, provided they use the JSR168
standard.

My BAC displays the main portal page of the user either when the user logs
in to HP Business Availability Center or when the user clicks the My BAC
tab. You can change the default page for a specific user by clicking SITE MAP
> Change the Default Page > Personal Settings > Menu Customization.

My BAC Portal Overview

My BAC portal is a view into HP Business Availability Center. The My BAC
administrator has set up your My BAC portal to include reports that are of
interest to you, as well as real-time views. The portal consists of modules,
pages and portlets.

You, the user, can personalize your own portal, by adding pages or portlets
to the portal, removing pages or portlets, rearranging existing pages and
portlets, setting an automatic page rotation, and editing a portlet
preferences to filter what is displayed in the portlet. You can also, in some of
the portlets, use context menu options to drill down to other reports. For
details on the context menu options available for each portlet, see the
documentation for each portlet. For details, see “Select Portlets to Add Area”
on page 103.

My BAC displays your main portal page either when you log in to
HP Business Availability Center or when you click the My BAC tab. This is
the page that the My BAC administrator has set up for you.

15
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Java and WSRP Portlets

16

You can import Java and WSRP portlets:

Java Portlets. Java portlets are portlets written in Java and imported into
My BAC. Java portlets consist of a portlet definition file and the Java code.

WSRP Portlets. Web Services for Remote Portlets (WSRP) are defined by a
producer Web service. HP Business Availability Center can consume WSRP
portlets from multiple sources:

» Imported portlets using the WSRP producer URL. When you use such
portlets, make sure the producer Web URL is available.

» Imported portlets from portals supported by HP (for example,
WebSphere, WebLogic, and HP products). When you use such portlets,
make sure that HP Business Availability Center is running before you
access the HP Business Availability Center WSRP portlets.

In addition, you can export WSRP portlets to other HP products. Export to
third-party portals is limited to certain environments. For more
information, see the My BAC Customer Support Knowledge Base article
49394.

Portlet Definitions

My BAC supports JSR 168 and WSRP standards-compliant portlets. This
support is based on the Apache Reference implementations of two
specifications: Pluto and WSRP4]J. However, the specifications may not be
complete in all areas or may be open to interpretation. HP has made design
decisions to cover these areas.

JSR 168 represents the Java Portlet Specification V1.0 that was developed
under the Java Community Process. The Java Portlet Specification defines a
contract between the portlet container and portlets and provides a
programming model for portlet developers.
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Web Services for Remote Portlets (WSRP) is a standard for content
aggregators, such as Web portals, to access and display content sources (that
is, portlets) that are hosted on a remote server. WSRP is a protocol designed
for accessing remote Portlets in a standard manner. The WSRP specification
defines a web-service interface for interacting with interactive presentation-
oriented web services.

WSRP portlets consist of a portlet definition file (in XML format) referencing
the HTTP location of the WSRP portlet. Portlet definitions are XML files that
define the look and feel of a portlet. Portlet definitions include such
information as the type of portlet, user and security group access rights to
the portlet, and filter definitions.

HP is committed to provide support for customers implementing these types
of portlets, including debugging and diagnosing problems related to

My BAC. HP does not extend that support to cover the debugging of custom
portlet code or configuration files.

Module/Page Tree

In My BAC Admin, the tree of modules displays the modules, pages, and
portlets created by the administrator in the Shared Pages pane, and your
private pages and portlets in the Private Pages pane. All the pages that you
see in both panes of the tree of pages are listed in the Switch to Page menu
in My BAC.

The administrator uses the module tree to:
» Configure modules and pages
» Optionally, add user-defined pages to the modules

» Add portlets to pages

For details about the tree of modules, see “Configure <module_name>
Dialog Box” on page 107.

17
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The user uses the page tree to:

» Create private pages and add portlets to those pages, in the Private Pages
pane.

» Copy modules or pages from the Shared Pages pane where the administrator
module pages are displayed, to the Private Pages pane and edit them,
depending on the type of access specified by the administrator.

» Create groups of pages in the Private Pages pane.

You can edit any element in the module/page tree by double-clicking it. You
can use the buttons above the tree to add modules/pages/portlets, clone
modules/pages, and more.

For details about the tree of pages, see “Edit Page Dialog Box” on page 124.

Note: If you have permission to see a portlet, you can display the page or
module for which you do not have permission if the portlet is included in
the page or module. Other portlets on the page or module display an error
message.

Set Up Licenses

To access specific data source portlets you must make sure you have the
appropriate licenses. The data sources are: Service Level Management, End
User Management, Dashboard, CMDB, and SOA. For details, see “License
Management” in Platform Administration.

Pre-Authenticated WSRP URLs

You can create a pre-authenticated WSRP URL to access My BAC portlets
from another portal.

For details, see “Create WSRP URL Dialog Box” on page 121.

18



Chapter 1 « My BAC

Import Portlets
Import a portlet using the steps listed in this section.
This task includes the following steps:

> “Import Portlet Definitions” on page 19
» “Configure a Portlet Definition” on page 19

> “Manage Portlet Categories” on page 20

Import Portlet Definitions

Import portlet definitions using one of the following methods:

» One by one. Use the Import Portlet Definition wizard. This consists in
selecting an existing Java or WSRP portlet, entering portlet information, and
configuring access to the portlet.

For details about Java or WSRP portlets, see “Java and WSRP Portlets” on
page 16.

For details about importing portlet definitions, see “Import Portlet
Definition Wizard” on page 135.

> More than one portlet at a time or together with module definitions. You
import portlet definitions and modules in separate files or in one file. You
would probably import a portlet definition or module when upgrading the
HP Business Availability Center version, or when moving data from a test to
a production environment. For details, see “Import My BAC Objects Dialog
Box” on page 134.

Configure a Portlet Definition

After you import a portlet definition, you can edit the portlet definition and
its access type. For details, see “Configure Portlet Definitions Dialog Box” on
page 114.

19
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Manage Portlet Categories

During the procedures for importing or configuring a portlet definition, you
select portlet categories that enable users to more easily find a specific
portlet to add to their portal. My BAC categories include HP Business
Availability Center applications such as Service Level Management,
Dashboard, and End User Management. You can add, remove, or change the
name of user-defined categories. For details, see “Manage Categories Dialog
Box” on page 143.

Import Portlets and Modules

You can import one or more portlet and one or more modules in one file, or
you can import each portlet or module in its own file. You would probably
import portlet definitions or modules when upgrading the HP Business
Availability Center version, or when moving data from a test or production
environment. For details on importing objects, see “Import My BAC Obijects
Dialog Box” on page 134.

Set Up a Module

20
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Setting up a module includes creating users and groups, creating a module (a
module includes pages that contain portlets), sharing the module to make it
available for copy and personalization to the allowed users (if the module is
not shared, the allowed users view the module in read-only mode), add
pages and portlets to the pages, and import user-defined pages.

This task includes the following steps:

“Create Users and Groups” on page 21

“Create a Module” on page 21

“Configure Access to the Module” on page 24

“Add Pages or User’s Pages to a Module” on page 24
“Add Pages or User’s Pages to a Module” on page 24
“Change the Order of the Pages in a Module” on page 25
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“Add Portlets to a Page” on page 25
“Edit/Customize a Portlet” on page 26
“Customize the Portlets in a Page” on page 26

“Filter a Portlet Display” on page 27

Create Users and Groups

Create the users and groups that will use My BAC. For details, see “User
Management Overview” in Platform Administration.

Create a Module

You create a module by:

Creating a new module. Define it by giving it a name and a description, and
specifying if it is enabled or disabled. For details, see “Configure
<module_name> Dialog Box” on page 107.

Cloning an existing module. You clone a module from the module tree.

Cloning a module saves time when you want to create slightly different
modules. For example, you want to have a module present specific
information for the past week and another module present the same
information for the last month. You would create the module with the
portlets presenting the information for the past week, then clone the
module, and for each portlet, redefine the time period to the past month.
For details, see “Edit Page Dialog Box” on page 124.

21
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Example-Create a New Module

This example shows how to create a new module, enter administrator’s
comments, and select the type of access to the module.

1 Access the Configure: New Module screen and enter information as follows:

Configure: New Module

Save

@ Header
Created By:  adminiztrator

Last Modified By: administrator  Last Modification Date: Dec 23, 2006

*Module Hame: ITraVEl Anent

Description: |Created for the Travel Agent

Enabled: (¥ Yes " No

@ Administrator Comments

Comments enables the administrator to share information sbout changes inthe module with the module recipierts.

Add Comment:  [Tyiz is the main travel agent module | || _ ¥iew Comments

[ |

@ Configure Access

Save

2 Expand Configure Access and select Allow access to all users in the User
Access area.

@ Configure Access

User Access
The followwing usersizecurity-groups will have read-only access to this module
W Allow access to all users

Mo Uzers

IUser ;II

[~ Enable users to copy this module pages to their private dashboard

3 Click Save.



Chapter 1 « My BAC

The result is as follows:

r

Gle x| |l ol=| ||

Successfully Saved st 12:11:30 AM PST

Configure: Travel Agent

@ Header
Created By:  administrator

Last Modified By: administrator  Last Modification Date: Dec 24, 2006

*Module Hame: |Travel Agent

Description: |Created for the Travel Agent

Enabled: (¥ ‘es (" hNo

@ Administrator Comments

@ Configure Access

4 You can now add/modify comments or configure/modify access to the
module. For details, see “Configure Access to the Module” on page 24.

Example-Clone a Module

For example, you created the Travel Agent module and you want to create a
clone of the module.

1 In the Modules tree, select the Travel Agent module, and click the Clone
o0 button.

“F O Modules
I
=~ e
l__1 Mew Page

2 The Modules tree displays the cloned module.

“H I Modules
L
—HC
l__1 Mew Page

+H Copy of Travel Agent

23
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Configure Access to the Module

After you create a module, you must configure it. To configure a module:

» Add comments (optional).

» Specify the type of access: read-only, modify, or self-service.

For details about configuring the module, see “Configure <module_name>
Dialog Box” on page 107.

Add Pages or User’s Pages to a Module

You can add blank pages or user pages to a module.

For details about adding an existing page to a module, see “Edit Page Dialog
Box” on page 124.

For details about adding a user’s page to a module, see “Add a User’s Pages to
Module Dialog Box” on page 104.
Example-Editing a Page

This example shows how to edit a page that is added in the module creation
process.

1 Right-click New Page and select Edit.

“H I Modules

L

“FH D Travel Agent
0

+H Copy of

X

Delata

P

Copy

Paste

Edit

View

Up

« » 8 3@

Down
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2 Enter the name of the page.

Edit page

Mote: The number of portlets per page is limited to 6.

*Page Name: ICruise 1]

- Automatically refresh this page every I minutes

Add PorHets

3 You can then add portlets to the page. For details, see “Add Portlets to
<page_name>/Add Portlets Dialog Box” on page 102.

Change the Order of the Pages in a Module

You can change the order of the pages in a module from the Modules tree.
For details, see “Edit Page Dialog Box” on page 124.

Add Portlets to a Page

You can add portlets to a page you are creating or to an existing page. For
details, see “Add Portlets to <page_name>/Add Portlets Dialog Box” on
page 102.

Note: If a portlet is added to a page, and is then disabled, the portlet is
removed from the page. If you re-enable the portlet it remains removed
from the page and you must add it again to the page.

Set Up CMDB Portlets

Before you add a CMDB portlet to a page you must set it up by adding the IP
addresses to a file listing the latitudes and longitudes of all countries. For
details on setting up CMDB portlets, see “Set Up CMDB Portlets” on

page 31.

25
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Add an RSS Portlet to a Page

Adding an RSS portlet to a page is done using a different procedure. For
details on setting up RSS portlets, see “RSS Area” on page 131.

Edit/Customize a Portlet

You can:

Change the portlet’s name.

Modify the portlet category.

Define the portlet display (narrow or wide).
Specify if the portlet is enabled or not.
Specify the portlet’s type of access.

For details, see “Configure Portlet Definitions Dialog Box” on page 114.

Customize the Portlets in a Page

You can customize the appearance of the portlets in a page. You can:

Change the default number (6) of portlets that can be assigned to a page.
Select Admin > Platform > Setup and Maintenance > Infrastructure Settings,
click Applications, select My BAC, locate the Maximum Number of Portlets
Per Page entry in the My BAC - My BAC table, and set the new maximum
number of portlets. System performance might be affected if this value is
larger than six. This setting is defined per HP Managed Software Solutions
customer.

Standardize the height of portlets per customer. Select Admin > Platform >
Setup and Maintenance > Infrastructure Settings, click Applications, select
My BAC, locate the Maximum height in pixels entry in the My BAC - My
BAC table, and set the maximum height (in pixels) for the portlet. The
minimum recommended height for a portlet is 300 pixels. If you do not
specify a value (default), each portlet uses the height that it needs.
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Filter a Portlet Display

Depending on the type of portlet, you can select the type of information
displayed in the portlet; for example, select a view, and specific CIs and Key
Performance Indicator (KPIs). You can also select the type of display you
want to use for the portlet; for example, displaying the View as Graph tab or
the View as Table tab.

For details, see “Edit Preferences <portlet_name> Dialog Box” on page 127.

Personalize Your My BAC Portal

Y VY VY Y

Your portal has been set up by the My BAC administrator and includes pages
that are of interest to you. You can personalize your My BAC portal by
creating groups of pages, creating private pages, adding portlets to pages,
copying and moving pages, copying and moving portlets, specifying and
running the pages rotation, and more.

This task includes the following steps:

“Add Pages to Your Portal” on page 27

“Manage the Pages in Your Portal” on page 28

“Create a Group of Pages and Add Pages to the Group” on page 28
“Manage the Portlets in Your Portal” on page 28

Add Pages to Your Portal

To add pages to your portal, you can:

Add an empty page to your portal. For details, see “Edit Page Dialog Box”
on page 124.

Add shared pages. Shared pages are either provided by HP or configured by
your My BAC administrator. After you add a shared page to your portal, you
can edit the page to meet your specific requirements. For details on adding a
preconfigured page, see “Add Preconfigured Pages Dialog Box” on page 103.
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Manage the Pages in Your Portal

You can manage your portal pages in the following ways:

Change the name of a page. For details, see “Edit Page Dialog Box” on
page 124 or “Configure Modules Dialog Box” on page 105.

Change the order of the pages. For details, see “Configure Modules Dialog
Box” on page 10S.

Specify and run the page rotation. For details, see “My BAC Page” on
page 146.

Create a Group of Pages and Add Pages to the Group

You can organize your pages into logical groups according to how you want
to use them. For example, if you want to monitor the same service for
different time periods (past week and past month), create a group of pages
that includes the monitoring portlets and set them up for the Past Week
time period, and create another group of pages that includes the same
monitoring portlets set up for the Past Month time period.

You can create standalone pages, with copies within groups, or pages can
exist only within a group.

For details, see “Edit Group Dialog Box” on page 123.

Manage the Portlets in Your Portal

You can manage the portlets in your portal pages in the following ways:

Add portlets to a page. You add portlets to a page you are creating a page or
to an existing page.

For details on adding a preconfigured page, see “Add Preconfigured Pages
Dialog Box” on page 103.

For details on adding a user or group preconfigured page, see “Users or
Groups Dialog Box” on page 151.
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Note:

» If a portlet is added to a page, and is then disabled, the portlet is removed
from the page. If you re-enable the portlet it remains removed from the

page.
» Before you add a CMDB portlet make sure that it has been set up
properly. For details, see “Set Up CMDB Portlets” on page 31.

» The procedure you use to add an RSS portlet is different from the regular
procedure. For details on setting up RSS portlets, see “RSS Area” on
page 131.

Modify a portlet, change its location on the page, and more. You change
the portlet location on the page, expand the portlet or shrink it, edit the
portlet preferences, change the portlet title, copy/paste a portlet to the same
page or move it to another page, or delete portlet information. For details on
adding a preconfigured page, see “Add Preconfigured Pages Dialog Box” on
page 103 or “Users or Groups Dialog Box” on page 151.

Edit/customize a portlet. You edit a portlet by:

» Changing the portlet title. Click the Change Title button and change the
title in the Change Portlet Title dialog box.

» Modifying the portlet preferences. Each portlet has different preferences.
For details about portlet preferences, see “Edit Preferences
<portlet_name> Dialog Box” on page 127.

» Modifying an SLM portlet advanced defaults. For details about portlet
preferences, see “Advanced Options Dialog Box” on page 10S5.
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Example-Clone a Portlet

Clone a portlet if you want to show the same report but for a different time
range. To clone the portlet, copy and paste it in the tree of pages/modules. A
copy of the portlet is added to the bottom of the page.

Filters ﬂ ﬂ ﬂ
KPls Over Time ﬂ ﬂ ﬂ
Top View «0+| 2| x|
Copy of KPlz Over Time «0+| 2| x|

Example- Change a Portlet Title

Change the current title of the portlet in your portal page from Top View to
End Users Monitor View. Edit the Top View portlet and click Change Title to
open the Change Portlet Title dialog box. Enter the new title.

Change Portlet Title

+Title: Ii]'gp Wieny

Change Cancel

The Edit Preferences page of the portlet displays the new title and the
default title included in brackets.

Edit Preferences: End Users Monitor View (Top View)

| |
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The new portlet title displayed in the portal is:

(Z End Users Monitor ¥iew =zl g

Export Portlets and Modules

You can export one or more portlets and one or more modules in one file, or
you can export each portlet or module in its own file. Save the resulting
XML file and import it into another HP Business Availability Center
instance. You would probably export a portlet definition or module when
upgrading the HP Business Availability Center version, or when moving
data from a test to a production environment.

For details on exporting objects, see “Export My BAC Objects Dialog Box”
on page 132.

Set Up CMDB Portlets

During discovery, HP Business Availability Center maps all IPs in the system.
You can attach physical location attributes (country, state, or city) to these
IPs to enable information to be broken down in the CMDB portlets by
location. For example, by linking IP addresses to certain locations, you can
view the distribution across servers for operating systems, applications,
network devices, and databases.

Set up the CMDB portlets by adding the IP addresses to a file listing the
latitudes and longitudes of all countries.

For details on discovery, see “Discovery Overview” in Discovery.
To attach location attributes to IPs:

1 Open the following file: <HP Business Availability Center root
directory>mam_lib\ collectors\probeManager\ip2location.csv.

2 Find the country, state, and city where the IP is located.
3 Add the IP address to the Rangel cell.
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You can add IP addresses in three formats:

» Single IP, for example, 192.168.82.100

» IP range, for example, 192.168.82.50-192.168.82.90
» Multi-IP range, for example, 192.168.*.*

You can add more than one IP address to the same location. Add the second
IP address to the Range2 column, the third IP address to Range3, and so on.
See the following figure for examples of ranges linked to locations:

s ] B | ¢ ] D [ E [ F [ G
1 |GLO_ID GLO_COUNGLO_STATGLO_CITY GLO_LATITUDE GLO_LONGITUDE Rangel
3870 5983 United Kingdom Hereford £2.06 -2.708
3871 7202 United Kingdom Hertford 51,795 -0.078
5703 United Kingdom High ‘Wycomhbe 51.633 -0,75 192,168.82,*
3873 11485 United Kingdom Hoddesdon 51,758 -0.022/192,168.82.48
3874 7128 United Kingdom Holyhead £3.31 -4.635192,168.82.10-192,168.82.90
3875 11150/ United Kinadam Hornchurch 1,556 0.214

Note: You cannot use this file to exclude ranges.

4 Save the file and restart the discovery probe: close the discovery probe DOS
command window and restart the discovery probe (Programs > Business
Availability Center > Administration > Discovery Probe).

Several hosts are running a J2EE application. During discovery, HP Business
Availability Center checks ip2location.csv and finds ranges that cover the
discovered host IP addresses.
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HP Business Availability Center updates the country, state, and city
attributes of each host IP CI. This process corresponds to the Group by
process performed in Group by dialog box accessed from the View Node
Definition dialog box in View Manager:

3 Group by

Use an Authenticated WSRP URL

When a consumer wants to use HP Business Availability Center as a
producer for a WSRP portlet, the consumer can use the WSRP URL of the
portlet to access the portlet without authentication or with authentication.

If the consumer creates the URL without credentials, when the user accesses
the portlet, the HP Business Availability Center login page is displayed (if
the user has Single Sign On this step is skipped), and then the portlet is
displayed. If the consumer creates the URL with credentials, when the user
accesses the portlet, he is automatically logged in with the credentials
included in the URL.
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Use a Non-Authenticated URL

Select Admin > Platform > Users and Permissions, and create a new user in
the Create New User dialog box. Enter the same user name for the consumer
user (in User Name) and for the HP Business Availability Center login (in
Login Name). Passwords are not necessary. Access the WSRP URL page, select
Authenticate with user from WSRP consumer, and click Create. Click Copy
to copy the string where needed. For details, see “Create WSRP URL Dialog
Box” on page 121.

When the consumer accesses the WSRP portlet, the authentication of the
consumer user name is automatically performed in HP Business Availability
Center using the user specified in the Create New User dialog box. The
consumer is then presented with the HP Business Availability Center login

page.

When using this method, consumer users can login to HP Business
Availability Center as separate users, but each user is presented with the
login page to HP Business Availability Center.

Use an Automatically Authenticated URL

Access the Create WSRP URL page, select Automatically authenticate with
the following credentials, enter the consumer user name in the User Name
box and the password in the Password box, and click Create. The user name
and password are added to the WSRP URL string. Click Copy to copy the
string where needed. For details, see “Create WSRP URL Dialog Box” on
page 121.

After login to the consumer site, the user accesses the WSRP portlet directly
without authentication.

When using this method, the user is not presented with the login page to
HP Business Availability Center, but all users login to HP Business
Availability Center with the same consumer user.
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Use an HTML Portlet

Use the HTML portlet to enter your own HTML code that you want to
display in a portlet in My BAC. You can then use the portlet like the other
portlets. The code is not verified.

Use regular HTML code.

Note: Use the iframe tag to access a specific site.

Example

The following code accesses the HP site and has a background image:

<html>
<body background='images\gui\logo_bg.gif>
<h2>HTML Portlet</h2>
Displays your personal HTML portlet.
<iframe src="http://www.hp.com' width=100%></iframe><br>
</body>
</html>

The result is:

() HTML Portlet

»Home & » Small & Medium » Large Enterprise » Government, Health & | » Graphic Arts
Home Office Business Business Education
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Deploy External Custom Java Portlets

36
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Note: This section is for advanced users or administrators.

Java portlets that comply with the Java Portlet Specification can be imported
and used in Dashboard. This section describes the processes used to deploy
external Java portlets.

This task includes the following steps:

“Implement the Portlet” on page 36
“Create a Web Archive for the Portlet” on page 37
“Create the MyPortletClass.class File” on page 37

“Make the portlet-wrapper.jar File Available to your Web Archive” on
page 37

“Add the Portlet Section to the portlet.xml file” on page 37

> “Add a Servlet Mapping to Your HP Business Availability Center Descriptor

File: web.xml” on page 39

» “PortletWrapperUtils API” on page 40

> “Import the New Portlet Definition” on page 40

» “Troubleshoot the Deployment of External Custom Java Portlets” on

page 40

Implement the Portlet

Portlets must be coded according to the Java Portlet Specification (JSR 168 -
see http://www.jcp.org/en/jsr/detail?id=168).

Example

You have coded a Java portlet called my.package.MyPortletClass, which is a
subclass of javax.portlet.GenericPortlet.
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Create a Web Archive for the Portlet

To separate standard Dashboard/Center code and custom portlet code,
deploy your custom Java portlet in a separate web archive in the new
directory myWebArchive.jar created in the deploy area of the Application
Server for your archive located at:

<HP Business Availability Center root directory>\AppServer\webapps\
site.war\WEB-INF\lib.

Note: Because myWebArchive.jar is deployed as part of HP Business
Availability Center deployment, it may have an impact on the deployment
of HP Business Availability Center.

Create the MyPortletClass.class File

In the Application Server, create the MyPortletClass.class class in
myWebArchive.jar.

Make the portlet-wrapper.jar File Available to your Web
Archive

For Dashboard to correctly process your portlet, make the
portlet-wrapper.jar file available to your web archive located in the
Dashboard distribution lib directory.

Place any other prepackaged Java libraries needed by your portlet in the
<HP Business Availability Center root directory>\AppServer\webapps\
site.war\WEB-INF\lib subdirectory, along with portlet-wrapper.jar files.

Add the Portlet Section to the portlet.xml file

This descriptor file defines the meta information needed by the portlet
container to run your portlet.

Modify the descriptor file in the
<HP Business Availability Center root directory>\AppServer\webapps\
site.war\WEB-INF\ portlet.xml file.
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Your portlet.xml should have the following structure:

<?xml version="1.0" encoding="UTF-8"?>
<portlet-app
xmins="http://java.sun.com/xml/ns/portlet/portlet-app_1_0.xsd"
version="1.0"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemal.ocation=
"http://java.sun.com/xml/ns/portlet/portlet-app_1_0.xsd
http://java.sun.com/xml/ns/portlet/portlet-app_1_0.xsd">
<portlet>
<I-- Specify a name you will use to refer to this portlet. -->
<portlet-name>MyPortlet</portlet-name>
<portlet-class>my.package.MyPortletClass</portlet-class>
<l-- Specify initialization parameters. Insert as many "init-param" tags as needed. -->
<init-param>
<name>param1Name</name>
<value>param1Value</value>
<[init-param>
<l-- Specify how long (seconds) the portlet container should cache this portlet's content. -->
<expiration-cache>0</expiration-cache>
<I-- Specify the modes available for this portlet. Available modes are "VIEW", "EDIT", and "HELP".
"VIEW" mode is not required by the portlet spec, but is an architectural requirement needed to
display the portlet. -->
<supports>
<mime-type>text/html</mime-type>
<portlet-mode>VIEW</portlet-mode>
<portlet-mode>EDIT</portlet-mode>
<portlet-mode>HELP</portlet-mode>
</supports>
<l-- Specify the set of preferences (if any) for this portlet, and default values.
Insert as many "preference" tags as necessary. -->
<portlet-preferences>
<preference>
<name>preferencelName</name>
<value>preference1Default</value>
</preference>
<preference>
<name>preference2Name</name>
<value>preference2Default</value>
</preference>
</portlet-preferences>
</portlet>
</portlet-app>

38



Chapter 1 « My BAC

Add a Servlet Mapping to Your HP Business Availability
Center Descriptor File: web.xml

Hook up your portlet to our central portlet-handling servlet in the main web
configuration file web.xml.

Modify the <HP Business Availability Center root
directory>\AppServer\webapps\site.war\WEB-INF\web.xml file as follows:

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE web-app PUBLIC "-//Sun Microsystems, Inc.//DTD Web Application
2.3/[EN" "http://java.sun.com/dtd/web-app_2_3.dtd">
<web-app>
<display-name>My Portlet</display-name>
<servlet>
<servlet-name>MyPortletServiet</servlet-name>
<display-name>My Portlet</display-name>
<description>My Portlet Wrapper</description>
<l-- This is the servlet used for all Dashboard portlet processing, and must be
specified exactly as follows. -->
<servlet-class>
com.mercury.dashboard.app.portal.PortletWrapperServlet
</servlet-class>
<init-param>
<param-name>portlet-class</param-name>
<param-value>my.package.MyPortletClass</param-value>
</init-param>
</servlet>

<servlet-mapping>
<servlet-name>MyPortletServlet</servlet-name>
<url-pattern>/MyPortletServletPath/*</url-pattern>
</servlet-mapping>
</web-app>
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PortletWrapperUtils API

Add portlet-wrapper.jar to your class-path to allow you (as the portlet
developer) to use its Dashboard Foundation-proprietary API. This API
provides several tools you can use while developing portlets and help you be
more aware of the portal environment. For example, you can use:

public static String getUserld(PortletRequest request) to get the user ID for
for the user who is invoking the portlet.

public static String getCustomerld(PortletRequest request) to get the
customer ID for the user who is invoking the portlet.

public static String getUniquePortletld(PortletRequest request) to
distinguish this portlet on the client (can be used as an HTML element id).

public static HttpServletRequest getHttpServiletRequest(PortletRequest
request) to get the HttpServletRequest from the PortletRequest.

Import the New Portlet Definition

To import, use the portlet import wizard Ul In the HTML interface, select
Administration > Portlet Definitions > Import a Portlet Definition, select to
import a Java Portlet, and follow the wizard instructions to choose your new
portlet and import it. For details, see “Import Portlet Definition Wizard” on
page 135.

After you finish importing a new portlet definition, you can add the portlet
to a page or a module.

Troubleshoot the Deployment of External Custom Java
Portlets

I have HP Business Availability Center configured in a cluster. What else do |
need to do to use my custom Java portlet?

This document describes deploying a custom portlet on a single Gateway
server. Multiple Gateway servers must each have access to the custom portlet
code. Therefore, you must repeat the steps outlined in this document to
deploy your Java portlet to each distinct Gateway server file system.

Or, as a shortcut, copy your web archive directory to the corresponding
location on each Gateway server, and update each Gateway server's
java_portlets.xml file accordingly.
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If | need to make changes to my Java portlet after it's imported into

HP Business Availability Center Dashboard, do | need to re-import it?
Delete the portlet definition from HP Business Availability Center. For
details, see “Configure Portlet Definitions Dialog Box” on page 114. Then,
stop and restart HP Business Availability Center and re-import the portlet
definition. For details, see “Import Portlet Definition Wizard” on page 135.

If | need to make changes to my Java portlet after it's imported into

HP Business Availability Center Dashboard, do | need to stop and restart the
Gateway server?

If your portlet uses JSPs, you can make modifications to the JSPs without
needing to restart the Gateway server.

If you change the portlet's Java code, any of the descriptor files, or if you re-
deploy your portlet's war file, you must stop and re-start the Gateway server.

IMPORTANT: JBoss's hot-deploy feature is not compatible with the Pluto
portal. If you hot-deploy the portlet, it stops working for all of your users
until you restart the Gateway server.
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Upgrade My BAC

This section describes how to upgrade My BAC.

Run DBVERIFY

To work with your old My BAC in the new version, run DBVERIFY to
upgrade the schema.

Upgrading the Schema, the Configuration and the Data

When you upgrade HP Business Availability Center from 6.x to 7.0, My BAC
Schema is upgraded but the configuration and the data are not upgraded at
that time. In such a case, when you try to open My BAC the following error
message is issued:

My BAC upgrade was not completed. You cannot access My BAC
application.
Contact your Administrator.

Additional errors are listed in the following file:
<HP Business Availability Center source directory>/
log/ejbcontainer/portal.log

Types of Access

42

Depending on the access definitions provided by the administrator at the
module, page, or portlet level, the user can have read-only access or can
copy pages from the Shared Pages area to the user Private Pages area and can
be edited there.

Type of Access What the Selected User/Security Group Can Do

Read-only access The selected users/security groups have read-only
access to the module or pages.

The user can view the module pages in My BAC
page but cannot modify those pages or the portlets

in those pages.
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Type of Access

What the Selected User/Security Group Can Do

Enable users to copy this
module pages to their
private dashboard

The selected users/security groups can copy the
module pages to their private My BAC area.

The user can view the module pages in My BAC
page and can modify those pages and the portlets in
the pages depending on the permissions for the
portlets.

Administrator Access

For future use.

Currently, users with the administrator permission
can modify all modules, all the module pages, and
all the portlets on the pages. For details about the
administrator permissions and where to set them,
see “User Management Overview” in Platform
Administration.

Self-Service Access

The selected users/security groups can add this
module to their My BAC portals as preconfigured
pages.

The user can view the module pages in My BAC
page and can modify those pages and the portlets in
the pages depending on the permissions for the
portlets.

Pre-configured modules or pages are optional. The
user can copy them to his private My BAC
dashboard area. They are not listed in the shared
area. They are accessible only by clicking the Add
Preconfigured Pages button in Personalize

My BAC. For details, see “Add Preconfigured Pages
Dialog Box” on page 103.
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Note: In My BAC Dashboard, you see the private pages you created in My
BAC, the pages that you are allowed to copy and modify, and the read-only
pages prepared by the administrator, filtered by the permissions defined for
the modules and portlet definitions in Platform Administration. For
example, you see the pages of the module and the portlets for which you
have permissions; the other portlets in the page do not display data and
include an error message that indicates that you do not have permission to
view the portlet. For details about the permissions defined in Platform
Administration, see “User Management Overview” in Platform
Administration.

Portlet Categories

44
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Different categories of portlets displaying different applications can be
added to My BAC pages and modules.

This different categories are:

“BPI Integration” on page 45
“Dashboard” on page 45

“End User Management” on page 47
“General” on page 50

“Report Builders” on page 51

“Service Level Management” on page 51
“SOA” on page 53

“UCMDB” on page 55
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Portlet Name

Description

Business Flow Diagram

Displays the Flow diagram of a BPI business process
that corresponds to the selected CI. For details, see
“Business Process Insight Portlet” on page 56.

Business Flow Thresholds

Displays the Metric thresholds for a BPI business
process that corresponds to the selected CI. For
details, see “Business Process Insight Portlet” on
page 56.

Dashboard

Portlet Name Description

Console Displays the components of the active Dashboard
view organized into the same hierarchy tree format
that you defined for the CIs in Dashboard
Administration. For details, see “Console Page” in
Using Dashboard.

Custom Map Displays a map for the selected view with the view's
CIs represented by real-time status indicators and a
background custom image that describes the real
world that your view represents. For details, see
“Custom Map Page” in Using Dashboard.

Filters

Displays, in a flat non-hierarchical way, the CIs that
match the following criteria: they belong to the
selected view, and at least one of their KPIs has the
status specified in the active filter. For details, see
“Filters Page” in Using Dashboard.

Geographical Map

Displays, on a geographical map, real-time status
indicators at the geographical location assigned to
the view's CIs. The status indicator shows the worst
status of the CIs at the geographical location. For
details, see “Geographical Map Page” in Using
Dashboard.
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Portlet Name

Description

KPIs Distribution Over
Time

Displays the distribution over time of the status of
selected Cls and KPIs. For details, see “KPIs
Distribution Over Time Report” in Using Dashboard.

KPIs Over Time

Displays the status or value, over time, of selected
CIs and KPIs. For details, see “KPIs Over Time
Report” in Using Dashboard.

KPIs Summary

Displays the statuses summary of selected CIs and
KPIs accessible from the Dashboard application. For
details, see “KPIs Summary Report” in Using
Dashboard

KPIs Trend

Displays the statuses trend of selected ClIs and KPIs
accessible from the Dashboard application. For
details, see “KPIs Trend Report” in Using Dashboard.

Top View

Displays CI bars that represent real-time IT
performance metrics mapped onto business
applications, linked by lines that represent
relationships between CIs. For details, see “Top View
Page” in Using Dashboard.

Topology Map

Displays a topology map that represents a pattern or
an instance view (defined in View Manager) with
the view's CIs and relationships. For details, see
“Topology Map Page” in Using Dashboard.
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End User Management

Portlet Name Description

End User - Least Available | Displays least available locations for Business
Locations Process Monitor across all profiles, for the last day.
This portlet displays one graph from the End User
Management Status Snapshot. For details, see
“Snapshot Viewer Page” in Using End User
Management.

End User - Least Available | Displays least available transactions for Business
Transactions Process Monitor across all profiles, for the last day.
This portlet displays one graph from the End User
Management Status Snapshot. For details, see
“Snapshot Viewer Page” in Using End User

Management.
Real User End Users by Displays data for a selected Web page configured for
Page Summary Real User Monitor in End User Management

Administration, broken down by end-user groups.
For details, see “End Users by Page Report” in End

User Management.
Real User End Users by Displays general, availability, total performance, net
Transaction Summary performance, or server performance data for each

end-user group that ran the transaction you
selected. For details, see “End Users by Transaction
Report” in End User Management.

Real User Event Analysis Displays data for a selected event type, broken
by End User Groups down by end-user groups. For details, see “Event
Analysis Report” in End User Management.

Real User Event Analysis Displays data for a selected event type, broken

by Pages down by pages. For details, see “Event Analysis
Report” in End User Management.

Real User Event Analysis Displays data for a selected event type, broken

by Servers down by servers. For details, see “Event Analysis

Report” in End User Management.
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Portlet Name

Description

Real User Monitor - Least
Available Applications

Displays least available applications for Real User
Monitor for the last day. This portlet displays one
graph from the End User Management Status
Snapshot. For details, see “Overview of Status
Snapshot” in Using End User Management.

Real User Monitor -
Slowest Applications

Displays slowest applications for Real User Monitor,
for the last day. This portlet displays one graph from
the End User Management Status Snapshot. For
details, see “Overview of Status Snapshot” in Using
End User Management.

Real User Monitor
Application Errors
Summary

Displays a summary of application errors in
monitored applications, configured in End User
Management Administration. For details, see “Pages
with Most Errors” in Using End User Management.

Real User Monitor Event
Count

Displays data for all events, or sessions with events,
in monitored applications, broken down by time
intervals. For details, see “Event Count Over Time
Report” in Using End User Management.

Real User Monitor HTTP
Errors Summary

Displays a summary of HTTP errors in monitored
applications, configured in End User Management
Administration. For details, see “Pages with Most
Errors” in Using End User Management.

Real User Monitor
Informational Events
Summary

Displays a summary of informational events in
monitored applications, configured in End User
Management Administration. For details, see “End
User Summary Report” in Using End User
Management.

Real User Monitor
Performance Events
Summary

Displays a summary of performance events in
monitored applications, configured in End User
Management Administration. For details, see “Event
Summary Report” in Using End User Management.

Real User Page Availability
Over Time

Displays details of the availability for the selected
Web page over the course of time. For details, see
“Page Over Time Report” in Using End User
Management.




Chapter 1 « My BAC

Portlet Name

Description

Real User Page Breakdown
Over Time

Displays details of the breakdown for the selected
Web page over time. For details, see “Page Over
Time Report” in Using End User Management.

Real User Page Hits
Availability Over Time

Displays details of the hits availability for the
selected Web page over time. For details, see “Page
Over Time Report” in Using End User Management.

Real User Page
Performance Over Time

Displays details of the performance for the selected
Web page over time. For details, see “Page Over
Time Report” in Using End User Management.

Real User Page Summary

Displays data for specific Web pages that were
configured for Real User Monitor in End User
Management Administration. For details, see “Page
Summary Report” in Using End User Management.

Real User Server Over
Time

Displays a graph and table of the server’s page hits
and availability over time. For details, see “Server
Over Time Report” in Using End User Management.

Real User Server Summary

Displays data for specific Web pages on the server
that were configured for Real User Monitor in End
User Management Administration. For details, see
“Page Summary Report” in Using End User
Management.

Real User Transaction
Availability Over Time

Displays details of the availability for the selected
transaction, over time. For details, see “Transaction
Over Time Report” in Using End User Management.

Real User Transaction
Breakdown Over Time

Displays details of the breakdown for the selected
transaction, over time. For details, see “Transaction
Over Time Report” in Using End User Management.

Real User Transaction Hits
Availability Over Time

Displays details of the availability for the selected
transaction, over time. For details, see “Transaction
Over Time Report” in Using End User Management.

Real User Transaction
Performance Over Time

Displays details of the performance for the selected
transaction, over time. For details, see “Transaction
Over Time Report” in Using End User Management.
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Portlet Name

Description

Real User Transaction
Summary

Displays data for specific transactions that were
configured for Real User Monitor in End User
Management Administration. For details, see
“Transaction Summary Report” in Using End User
Management.

Triage Report - Error
Details

Displays error details for Business Process Monitor.
For details, see “Triage Report” in Using End User
Management.

Triage Report - Error
Summary

Displays a summary of errors organized by error
type for Business Process Monitor. For details, see
“Triage Report” in Using End User Management.

Triage Report - Raw Data

Displays raw data information for Business Process
Monitor. For details, see “Triage Report” in Using
End User Management.

Triage Report -
Transaction Breakdown

Displays a breakdown over time of response time
data for Business Process Monitor. For details, see
“Triage Report” in Using End User Management.

Triage Report -
Transaction Group by
Location

Displays an in-depth picture of the performance of
transactions grouped by locations for Business
Process Monitor. For details, see “Triage Report” in
Using End User Management.

General

Portlet Name

Description

HTML Portlet

Displays any HTML content

RSS Portlet

RSS (Really Simple Syndication) is an XML-based
format for sharing and distributing Web content,
such as news headlines. For details, see “RSS Portlet”
on page 59.

Welcome to My BAC
Application

Displays an introduction to the My BAC
Application. For details, see “Welcome to My BAC
Application Portlet” on page 58.
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Portlet Name

Description

Custom Query Builder

Displays a table of data retrieved from the database,
answering to a Generic Reporting Engine API query.
For details, see “Custom Query Builder” in Custom
Reporting and Alerting.

Service Report

Displays a personalized table report constructed
over several data sources. For details, see “Service
Report User Interface” on page 153.

Service Level Management

Portlet Name

Description

SLA Status Portlet

Displays the SLA forecast status for the end of a
calculation period, compared with the current SLA
status. For details, see “SLA Status Report” in Using
Service Level Management.

SLA Summary Portlet

Displays a list of SLAs and their statuses, filtered by
KP], time interval, calendar, time period. For details,
see “SLAs Summary Report” in Using Service Level
Management.

SLM CI Impact Portlet

Displays the results for a CI across all SLAs in which
the CI is defined, filtered by KPI, time interval,
calendar, time period. For details, see “CI Impact
Report” in Using Service Level Management.

SLM CI Status Portlet

Displays the results for a CI and its descendants. For
details, see “CI Status Report” in Using Service Level
Management.

SLM CI Summary Portlet

Displays a summary of all CIs for a specific SLA. For
details, see “CI Summary Report” in Using Service
Level Management.

SLM Cls Over Time Portlet

Displays ClIs over a time period, for a selected SLA.
For details, see “Cls Over Time Report” in Using
Service Level Management.
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Portlet Name

Description

SLM ClIs Over Time vs.
Target Portlet

Displays defined targets superimposed on the data
of ClIs for a selected SLA. For details, see “CI Over
Time vs. Target Report” in Using Service Level
Management.

SLM Outage Breakdown
Portlet

Displays breakdown of all outages for selected CIs
for one SLA, for specific calendar. For details, see
“Outage Breakdown Report” in Using Service Level
Management.

SLM Outage Summary
Portlet

Displays the periods of time during which
measurements (transaction, monitor, sample) failed,
that is, did not meet criteria defined in the KPI's
business rule. For details, see “Outage Summary
Report” in Using Service Level Management.

SLM Outages Distribution
Portlet

Displays a distribution of outages for selected ClIs.
For details, see “Outage Distribution Report” in
Using Service Level Management.

SLM Time Range
Comparison Portlet

Displays the status of four levels of Cls: a CI's status
(can be an SLA) and the statuses of the CI's children,
organized by time range, for a selected KPI and
calendar. For details, see “Time Range Comparison
Report” in Using Service Level Management.

Worst-Performing SLAs -
Current Periods Portlet

Displays the latest status of the ten worst-
performing SLAs. For details, see “Worst-Performing
SLAs - Current Periods Area” in Using Service Level
Management.

Worst-Performing SLAs -
Previous Periods Portlet

Displays the worst-performing SLAs for the past six
months. For details, see “Worst-Performing SLAs —
Previous Periods” in Using Service Level Management.
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Portlet Name

Description

Least Active Web
Service/Operation

Displays the five Web services/operations that
received the lowest number of calls (that is, were
least used), during the selected time frame of the
report. For details, see “Top Metrics Report” in
Solutions and Integrations.

Least Available Web
Service/Operation

Displays the availability of the five Web
services/operations with the lowest availability,
during the selected time frame of the report. For
details, see “Top Metrics Report” in Solutions and
Integrations.

Most Active Web
Service/Operation

Displays the five Web services/operations with the
highest number of calls, during the selected time
frame of the report. For details, see “Top Metrics
Report” in Solutions and Integrations.

Slowest Web
Service/Operation

Displays the five slowest Web services/operations in
the selected time frame of the report. For details, see
“Top Metrics Report” in Solutions and Integrations.

SOA Consumer Summary

Displays specific metrics for all of the consumers
accessing the selected Web services or operations in
a selected view. For details, see “Consumer
Summary Report” in Solutions and Integrations.

SOA Metrics Over Time

Displays the performance, over time, measuring
access to selected Web services or operations, by a
server, or a consumer. For details, see “Metrics Over
Time Report” in Solutions and Integrations.

SOA Server Summary

Displays the health metrics for all of the servers on
which the selected Web services or operations are
running. For details, see “Server Summary Report”
in Solutions and Integrations.

SOA Worst Consumers

Displays the successful and faulty calls of the worst
five consumers accessing the selected Web services,
operations, or servers. For details, see “Consumer
Summary Report” in Solutions and Integrations.
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Portlet Name

Description

SOA Worst Servers

Displays the successful and faulty calls of the worst
five servers accessing by the selected Web services,
operations, or consumer. For details, see “Server
Summary Report” in Solutions and Integrations.

Web Service/Operation
With Most SOAP Faults

Displays the five Web services/operations with the
largest number of received SOAP faults, during the
selected time frame of the report. For details, see
“Top Metrics Report” in Solutions and Integrations

Web Service/Operation
With Slowest Number of
Calls

Displays the five Web services/operations with the
highest number of slow calls, in the selected time
frame of the report. For details, see “Top Metrics
Report” in Solutions and Integrations

Web Services/Operations
Health Summary

Displays health metrics for the selected Web
services, or operations in a selected view. For details,
see “Health Report” in Solutions and Integrations.
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Portlet Name

Description

Changed Applications

Displays the number of detected changes in
applications within a defined period. For details, see
“Changed Applications” in IT World Model
Management.

Changed Views

Displays a bar graph showing the number of
changes that occurred in a specific view within a
defined period. For details, see “Changed Views” in
IT World Model Management.

CMDB Overview

Displays general CMDB statistics. For details, see
“CMDB Utilization” in IT World Model Management.

Database Breakdown

Displays a pie chart showing the breakdown of
database types and versions. For details, see
“Database Breakdown” in IT World Model
Management.

Delete Candidates

Displays a bar graph showing the Cls and
relationships that were deleted within a defined
period and the ones that are about to be deleted.
For details, see “Delete Candidates Overview” in
IT World Model Management.

Discovery Job Errors
Report

View Discovery jobs that currently have errors. For
details, see “Discovery Job Errors Report” in
Discovery.

Discovery Job Statistics
Report

View statistics for Discovery jobs. For details, see
“Discovery Job Statistics Report” in Discovery.

Host O/S Breakdown

Displays a breakdown of operating systems. You can
view all deployed operating systems or you can
view data for operating systems at a certain location
or running on a certain subnet. For details, see
“Host O/S Breakdown” in IT World Model
Management.
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Portlet Name

Description

Major Application Type
Breakdown

Displays a breakdown of major applications and
their versions. You can view all applications
deployed in the system or you can view data for
applications at a certain location. For details, see
“Major Application Type Breakdown” in IT World
Model Management.

Network Device
Breakdown

Displays a breakdown of network devices and their
manufacturers. You can view all network devices
deployed in the system or at a certain location. For
details, see “Network Device Breakdown” in

IT World Model Management.

Number of Changes

Displays a bar graph showing the number of
detected changes in a CIT within a defined period.
You can also view the breakdown of the types of
changes that occurred for the CIT and its
descendants. For details, see “Number of Changes”
in IT World Model Management.

Business Process Insight Portlet

56

The Business Process Insight portlets display data obtained from the
HP Business Process Insight application.

The Business Process Insight portlets are included in the BPI Integration

category.

For additional information about the integration of HP Business Process
Insight data into HP Business Availability Center, see “Integrate HP Business
Process Insight Data Into HP Business Availability Center” in Solutions and

Integrations.
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This section includes the following topics:

> “Business Flow Diagram Portlet” on page 57

> “Business Flow Thresholds Portlet” on page 58

Business Flow Diagram Portlet

This portlet displays the Flow diagram of a BPI business process that
corresponds to the selected CI. For more information, see HP Business
Process Insight documentation.
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Business Flow Thresholds Portlet

This portlet displays the Metric thresholds for a BPI business process that
corresponds to the selected configuration item. For more information, see
HP Business Process Insight documentation.

(% BPI Flow Threshold Diagram 22l gl

#transfers at Check Funds  § Transfer amount at Check Funds Avg time to Check Funds

3736 20,455,236 No Value Available

§ Total amount in transfer

20,470,336

Welcome to My BAC Application Portlet

The Welcome to My BAC Application portlet displays an introduction to
My BAC that explains how to work with the My BAC application.

(& Welcome to My BAC Application =zl g

My BAC portal is a real-time view into HP Business Availability Center. The My BAC administrator has set up your
My BAC portal to include the Dashhoard, Service Level Management, End User Management, Service
Oriented Architecture {SOA), and Business Dashboard reports that are of interest to yvou,

®*  Toview other pages, click Switch to page or the arrows on baoth sides and select a page, You can copy
and modify the read-write pages.

®  Tp customize pages or portlets, click Personalize, or click Edit in the portlet title bar.,

®*  Toyiew the My BAC Administrator comments about the current page, click Comments.

®  Tg setthe page rotation, click the Rotation button,
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The RSS portlet displays an Real Simple Syndication (RSS) feed: RSS is an
XML-based format for sharing and distributing Web content such as news
headlines.

The My BAC RSS parser supports RSS versions 1 and 2. To view RSS portlets,
HP Business Availability Center must have access to the Internet.

(Z) RSS Portlet

7]

invent

Survey: Business Continuity and Availability
Solutions a High Priority for Corporate
Spending in 2007

Findings reveal 18 percent of enterprises, 31
percent of small businesses have no business
continuity plan

HP ta Acquire Tabbla, Airms to Make Printing
frorm Web Easier

HP today announced it has signed a definitive
agreement to acquire Tabblo Inc, a privately-
held developer of web-based software located
in Cambridge, Mass,

HF Showcases Technology to Help Federal
Agencies Transformn IT Enviranrnents

HP today announced technology solutions
designed to help U5, federal agencies
rnanage and transfarm their IT environments
to optimize outcormes, lower costs, increase
security and mitigate risks,

Cllefml

The procedure for adding an RSS portlet is different than that for adding
other portlets. For details, see RSS Area in “Edit Preferences <portlet_name>
Dialog Box” on page 127.

Default Module

By default, My BAC includes an out-of-the-box default module that includes
the following pages and portlets:

» Dashboard page:

» Top View

» Filters

» Welcome to My BAC Applet
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» Dashboard Reports:
» KPIs Trend
» KPIs Summary
» KPIs Distribution Over Time
» Service Level Management:
» Worst Performing SLAs - Previous Periods Portlets
» Worst Performing SLAs - Current Periods Portlets
» End User Management:
» End User - Least Available Locations
» End User - Least Available Transactions
> SOA:
Web Service/Operation With Slowest Number of Calls

Slowest Web Service/Operation

>

>

» Least Active Web Service/Operation

» Least Available Web Service/Operation
» Most Active Web Service/Operation

>

Web Service/Operation With Most SOAP Faults

My BAC also includes the out-of-the-box UCMDB default module that
includes the following pages and portlets:

» CMDB:
» CMDB Utilization
Delete Candidates

>

» Host O/S Breakdown
» Database Breakdown
>

Major Application Type Breakdown
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» Network Device Breakdown
» Change:

» Number of Changes

» Changed View

» Changed Applications
» Discovery:

» Discovery Job Report

» Discovery Job Errors

For more details about the portlets, see “Portlet Categories” on page 44.

Note: A user cannot edit the Default Module and the default UCMDB
module in My BAC. A user with administrative permissions can edit the
default modules in My BAC Administration.

WSRP Portlets on Solaris with an IPlanet Web Server

If you are using WSRP portlets and HP Business Availability Center is
running on Solaris with an IPlanet Web Server, in the IPlanet obj.conf file
under the line NameTrans fn="assign-name" from="/topaz/dashboard/*"
name="]2FRedirect", add the line: NameTrans fn="assign-name"
from="/dashboard/*" name=")2FRedirect"
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Change the Status Alert Sound

If you want to use a different alert sound and you are a user with
administrative permissions, access <HP Business Availability Center server
root directory>\AppServer\ webapps\site.war\bam\

pages\sounds and replace the ding.wav file with your own WAV file (you
must rename your file ding.wav).

Note: The change takes effect immediately.

Troubleshooting and Limitations

62

This section includes My BAC troubleshooting and limitations.

Customer support. To facilitate diagnosis, customers reporting problems to
Customer Support are required to provide a simple, reproducible case that
demonstrates the error in the My BAC portal.

CMDB portlets. To view the CMDB portlets and the CMDB category in the
list of available portlets, you must have performed the procedure described
in “Set Up CMDB Portlets” on page 31.

Access to a portlet definition. Access is given, by default, to all users and all
administrators. If you assign access rights to specific users or security groups,
or to specific administrators, My BAC removes the All Users or All Portlet
Definition Administrators security type from the list and replaces the type with
the user, security group, or administrator you chose.

WSRP portlets. To be able to view HP Business Availability Center WSRP
portlets, a user must, at least once, login to the HP Business Availability
Center application and open the My BAC application every time

HP Business Availability Center has been restarted.
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Service Report

This chapter includes the main concepts of the Service Report.

Troubleshooting and Limitations

This chapter describes: On page:

Concepts

Service Report Overview 64

Dimensions and Measurements 64

Service Report Formats 68

Status Function Automatic Measurements 71

Tips and Tricks 72

Tasks

Configure a Service Report 75

Create a Customized Measurement 82

General Reference

Service Level Management - SLA KPI Data Dimensions and 87

Measurements Map

Service Level Management - SLA Status Data Dimensions and 90

Measurements Map

Dashboard KPIs Data Source Dimensions and Measurements 93

Over Time Additional Data Dimensions and Measurements Map 95
96

63
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Service Report Overview

Service Reports are based on data from data sources from the Service Level
Management or Dashboard application.

You can create a Service Report by selecting the Service Report portlet in
My BAC, or by adding the Service Report component to a custom report.

For details about custom reports, see “Custom Report Manager” in Custom
Reporting and Alerting.

Dimensions and Measurements

64

The Service Report uses data from the CMDB and Profile databases
corresponding to the data source of the different applications. These
databases are configured for Online Analytical Processing (OLAP) and
employ a multidimensional data model. The multidimensional data model
creates a matrix of measurements and dimensions (cube) that maps and
links them in a specific way for each application.

This section includes the following topics:

> “Dimensions and Measurements Overview” on page 65

» “Impact of the Dimensions/Measurement Selection on the Report Structure”

on page 66

“Impact on the Type of Selection: Single Selection or Multiple Selection” on
page 66
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Dimensions and Measurements Overview

When you configure a Service Report as a portlet in My BAC or as a
component in a custom report, you specify the source of the data, and you
select the dimensions and measurements available from the data source that
you want to display in the report.

For example, when you create an SLA in Service Level Management, you
specify properties such as SLA name, Customer, Provider, and so on, which
you use to get information about the status of the SLA. All the properties can
be used as dimensions in Service Reports for the Service Level Management
application. For details, about the SLA properties, see “Agreement Wizard”
in Using Service Level Management.

The measurements that are available depend on the dimensions and on the
data sources you selected. The measurements are the parameters of the
dimensions. For example, the measurements of the SLA dimension are the
attributes of the SLA: Customer, Provider, Value, Objectives, and so on.

When you select one or more data sources in the Service Report wizard, the
dimensions and the measurements are linked by a map. Those links have an
impact on the elements that you can select when building the report and on
the possible location of those elements in the report. For details about the
maps, see the General Reference section in this chapter.

Note: When you select more than one data source in the Service Report
Builder wizard, the dimensions and measurements maps are combined.
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Impact of the Dimensions/Measurement Selection on the
Report Structure

Some measurements automatically assume a specified position in the
Service Report; for example in the Service Level Management - SLA Status
Data data source, the SLA Overall Status measurement has a one-to-one link
to the SLA dimension and is automatically orthogonal to the SLA dimension
in the report. For details, see “Service Level Management - SLA Status Data
Dimensions and Measurements Map” on page 90.

Other measurements (such as Forecast Status, or SLA Breached Date) have a
one-to-many relation with multiple dimensions. In addition they are linked
to the same dimensions (they are in the same box in the map; see “Select the
Dimension Filters” on page 161). Therefore, they do not have an automatic
position in the report, and you must select where you want them to be
displayed by selecting As column headers or As row headers.

Impact on the Type of Selection: Single Selection or
Multiple Selection

If you select a dimension (SLA) and a measurement (SLA Overall Status) that
are simply linked to each other in the dimensions and measurements map,
the Dimensions Filter displays a multiple-selection for the SLA dimension.
This is because there is only one customer for each SLA. The values you can
select from are the available SLAs.

Mandatory Dimensions:

S Selact Fram: ISLAS vl
S5LAs
v SLA - all services
Il SLal
I sLAzZ

SLAZ
SLAd4

v
e | 0h | mh
b e
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If you select a measurement (SLA Forecast Status) that is linked to several
dimensions in the map (Forecast Based on Tracking Period, SLA, and
Tracking Period) and you have selected only one dimension (SLA) in the
Dimensions Selection page, the Dimensions Filter displays all the other
dimensions that are mapped to the measurement. For details about the map,
see “Service Level Management - SLA Status Data Dimensions and
Measurements Map” on page 90.

This is because of the multidimensional data model of the databases where
the data is located. To access the SLA Forecast Status measurement data
relevant to the SLA dimension that you selected, you must also provide the
values for the other dimensions in the data model.

The dimension you selected in the Select Dimensions page (SLA) is multi-
selection and you must make a choice from among the available
dimensions. Each of the other dimensions linked to the selected
measurement is single-selection (fixed dimension).

Mandatory Dimensions:

sLA ' Last Month
Forecast Based On  Last Cay
Tracking Period r
Last Wear
Tracking Period
' Last Quarter
© Last week

7 Manth to date
' vearto date

' Quarter to date
 week to date

Multi-selection is different for each dimension.
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Service Report Formats

You can format the Service Report by selecting columns and row headers, by
adding different column types in the same table, customizing the report
structure, adding calculated columns, and combining data from multiple
sources, such as SLM and additional data source.

The Service Report can have the following format:

> Pivot table. You can use dimensions and measurements to create multiple
column or row headers and you can choose where to locate them in the
table. For example, a pivot table can have the following structure:

Status

Tinte Range1
CIi
Time Range2

Time Range1
CI2
Time Range2

Exceeded
Mo Data
Met

Minor Breached

» Deeper hierarchy. You can select several dimensions to be the column
headers and more than one dimension to be the rows header. For example, a
deeper hierarchy table with 3 headers is as follows:

Time Range2

Status Pepeentay
crp | KPIL _{\‘ L 11,47
KR AT () TN
KPI1 4,81
CcIz
KPIZ 19.54

Status Percentage (%) Event Count(#)
13.99 26
ig.10 34
13.05 15}
12,41 71

» Measurements per dimension. For each dimension, you can select what you
want to display: values, status, objectives, background status color, and so
on. An example of such a table is as follows:

TimaeKange 1

Time Range2

Status Pepeentage (W) S5tatus Percentage(9t) Event Count(#)
i1 KPI1 A1 13,99 26
%
kP12 N @) Nadssa) 18.10 3¢
KPIL 4,81 13,05 68
cI2
KPIZ 19,54 12,41 71
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Note: In the regular cells of a table, numeric content is right-aligned and
text content is left-aligned. In header cells, the cell content is centered.

Other Possible Structures

A Service Report can display:

» The value of the measurement:

Availability Performance
24x7 Business 24x7 Business
Hours Hours
CI1 90 80 90 70
CI2 10 20 10 30
» The status of the measurement:
Availability Performance
24x7 Business 24x7 Business
Hours Hours
CI1 Breached Minor Met Met
breached
CI2 Exceeded Met Exceeded Met

69



Chapter 2  Service Report

» Both the value and status of the measurement. You can choose between two
different structures:

» Vertical merge (select As column headers):

Availability Performance
24x7 Business Hours 24x7 Business Hours
Value | Status Value Status Value | Status Value | Status
CI1 90 Breached | 80 Minor 90 Met 70 Met
breached
CI2 10 Exceeded | 20 Met 10 Exceeded | 30 Met

» Horizontal merge (select As Row headers):

Availability Performance
24x7 Business 24x7 Business
Hours Hours
CI1 Value 90 80 90 70
Status Breached Minor Met Met
breached
CI2 Value 10 20 10 30
Status Exceeded Met Exceeded | Met
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Status Function Automatic Measurements

When you use the Status function to create a calculated measurement, it
automatically creates the following measurements:

» <Compare_measurement_selection> (<new_measurement_name> as
background). This measurement displays the value of the measurement you
selected in the Compare measurement list and the status of the
measurement when compared to the thresholds you selected in To
threshold as the background color for the cell in the table.

SLA1 SLAZ
KPI1 32 38
CI/Servicel
KPIZ 24 47
KPI1 a0 51
£l fEervice?
Kprz 50

» <new_measurement_name>. This measurement displays the status of the
measurement you selected in the Compare measurement list when
compared to the thresholds you selected in To threshold as the name of the

threshold.
S5LA1 S5LAZ
KPI1 Exceeded Failed
CI/Servicel
KPI2 Exceeded Failed
KPI1 Excesded Excesded
CI/Servicel
KPI2 Excesded Excesded

> <new_measurement_name> (<new_measurement_name> as background).
This measurement displays the status of the measurement you selected in
the Compare measurement list when compared to the thresholds you
selected in To threshold as the name of the threshold and as the background
color for the cell in the table.

S5LA1 S5LAZ
KPI1 Exceeded Exceeded
CI/Servicel
KPI2 Excesded h
KPI1 Exceadead Exceaded

CI/Semice?

kpi2 N cec =)
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> <new_measurement_name> as background. This measurement displays the

status of the measurement you selected in the Compare measurement list
when compared to the thresholds you selected in To threshold as the
background color for the cell in the table.

SLAL S5LAZ

KPI1
KPI2
KPI1
KPIZ

CI/Servicel

£l fservice 2

Tips and Tricks

72

This section includes tips and tricks that you can use when creating a Service
Report.

General

Selecting the Enable automatic preview option is very useful to see the
changes you make to the report before you generate the report.

Click CTRL and use the mouse to perform a multi-selection of dimensions or
measurements.

When you create a service report based on the Service Level Management
data sources, you can display data for the Targets measurements, only of all
the ClIs included in the same SLA have the same threshold. Data is displayed
if all the thresholds are linked to the SLAs, Cls/Services, and KPlIs
dimensions, if for all the Calendar, and Target measurements, are the same.

After you have created a service report, you can clone it by copying and
pasting them in the tree of pages. For details, “Edit Page Dialog Box” on
page 124. For example about one of the uses of cloning a service report, see
“Example—Create a Service Report for Online and for Print” on page 81.
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Select Dimensions Page

It is recommended, when creating a service report, to distribute the
dimensions between the Rows and the Columns. In the measurement maps,
check the dimension that are linked to the measurements you are selecting.
Then try to distribute those dimensions between the rows and columns. For
example, if you want to display the KPI Value and Targets - All
measurements and you have selected the Calendar, Cl/Services, and SLAs
dimensions, it is recommended to select Cl/Services and SLAs not on the
same side.

Calendari Calendar? Targets - All
SiLA1 = = Targets - All1
CI/ Servicel
sLAZ ° ° Targets - Allz
SLA1 - - Targets - All3
CI/ Service?
SLAZ - - Targets - All4

Reports where you have moved the majority of the dimensions to the
Columns box are wide, which might cause printing problems. Reports where
you have moved the majority of the dimensions to the Rows box are long.

If you have selected the SLAs and Calendar dimensions, and you want to
display data for lots of SLAs, it is recommended to set SLAs in Rows and
Calendar in Columns. If vice versa, you want to display data for lots of time
intervals for a limited number of SLAs, it is recommended to set SLAs in
Columns and Calendar in Rows.

Select Measurements Page

To create a narrower report, move the measurements to the Rows box if you
have moved the majority of the dimensions to the Columns box (or vice
versa). This way, a new measurement adds one more row to the report.

The order of the measurements in the Available Measurements box in the
Select Measurements page is by order of importance and not by alphabetical
order.
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>

If you get the error message: Some of the selections are incompatible and
cause problems in the report structure (or Errors were encountered while
trying to build the report), change the order of the selected dimensions in
the Select Dimensions page or the order of the measurements in the Select
Measurements page. If that does not work, move the order of the selections
in the Rows and Columns boxes in the Select Dimensions page.

If you add a calculated measurement and regular measurements to a report,
the order of appearance of the measurements is always regular
measurements before calculated independently of your choice in the
selection lists.

Calculated Measurement

It is important to add a meaningful description when you create a new
measurement because the description appears as a tooltip in the report and
to describe what the measurement represents: the measurements that are
used, the type of calculation, the dimension on which the calculation is
based, and so on. For example, the difference between the SLA KPI value and
the target Exceeded, compared by Time interval.

To make sure that you are using the Difference calculated measurement in
the correct wayj, it is recommended to add the measurements you selected in
the First measurement and in the Second measurement boxes to the report
and to verify that the Difference calculation is done in the correct order. If it
does not, switch the measurements you selected from the First
measurement to the Second measurement boxes and vice versa.

All dimensions that you did not select in the Select Dimensions page can be
used as the base for an aggregation measurement, but you do not have to
necessarily select multiple values in the Select Dimensions Filter page. For
example, you have selected the SLA and Cls/Services dimensions in rows
and the KPIs in columns; you can perform an aggregation over the Time
Interval or the Calendar dimensions, which were not selected. In the Select
Dimensions Filter page, both dimensions are multi-selection, but you can
select multiple values for one dimension and one value for the other
dimension; for example, Last week and every one week.
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Select Dimensions Filter Page

In the Select Dimensions Filter page, to see the filtering take place as you are
selecting by clicking Preview or if you have the Enable automatic preview
option selected and by selecting another dimension in the list.

Configure a Service Report

Y Y Y Y Y VY VY Y

You can add a Service Report to a page in My BAC or to a custom report, and
then you configure the Service Report using a wizard.

This task includes the following steps:

“Add a Service Report Portlet to a Page” on page 75
“Edit the Service Report Portlet” on page 76
“Select a Data Source” on page 76

“Select the Dimensions” on page 77

“Create a Customized Measurement” on page 78
“Select the Measurements” on page 78

“Select the Dimensions Filter” on page 79

“View the Summary” on page 81

Add a Service Report Portlet to a Page

Add a Service Report portlet to a page in My BAC. For details, see “Add
Portlets to <page_name>/Add Portlets Dialog Box” on page 102.

Note: You can also add a Service Report component to a custom report. For
details about custom reports, see “Custom Report Manager” in Custom
Reporting and Alerting.
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Edit the Service Report Portlet

In the Edit Page dialog box, in the Service Report portlet, click the Edit
button to open the Edit Preferences page.

» Expand Advanced Settings and select the refresh rate for the portlet.

» Click Launch Service Report Builder to open the wizard that creates the

Service Report.

For details, see “Edit Preferences <portlet_name> Dialog Box” on page 127.

Select a Data Source

Select the data source on which you want to base the Service Report. For
details, see “Select a Data Source Page” on page 154.

Example Scenario-Creating a Service Report Based on
Dashboard KPIs Data

In the Select a Data Source page, select Dashboard KPIs data and click Next.

Select a Data Source

The Service Report is based on the selected data source dimensions and measurements,
Select at least one of the following data sources:

Service Level Management - SLA KPI data Provides the CIs, KPIz, SLA, Time, and Calendar dimensions, and the KPI Walue,

KPI Status, Additional Values and Objectives measurements,

I- Service Lewel Management - SLA Status data Provides the SLA, Tracking Periad , "Based On" Tracking Period, and Time

dimmensions, and the SLA Status for Previous Periods, SLA Current Status, SLA
Current Status By Time Period and SLA Forecast measurernents,

[¥ Dashboard KPIs data Provides high-level analysis for business-related CIs, based on histarical data

from the assocated Dashboard KPIs,

[ Ower Time Additional Data Pravides additional data such as Mumber of tickets and Number of users

rneasurernents, for ©Is and Tirme range dimensions, from rmultiple data sources,
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Select the Dimensions

Select the data source dimensions you want to use to create the Service
Report and specify their order in the report. For details, see “Select
Dimensions Page” on page 15S5.

Example Scenario-Creating a Service Report Based on
Dashboard KPIs Data

In the Select Dimensions page, select Cl/Service and KPI as rows and Time
Range as column and click Next.

Select Dimensions

The Awailable Dimensions area lists the data source dimmensions you selected in the Select a Data Source page.
Move the dimensions to the Columns or Rows area,

Available Dimensions: Rows:

Cirnensions in the Rows area appear as row

Status =» ClfService
headers,
KPI

|

HE

Columns:

Cirnensions in the Columns area appear as

Tirme Range
9 column headers,

HE

Clear
Click Preview to display the structure of the report. The data and
background color are for illustration purposes only.
A% Time Rangel Time Range
KPI1 17:46:40 20:16:40
CI1
Kp1z 26140
KPTi 02:46:40 1 day, O haours
c1z
. .xd | 1615640
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Create a Customized Measurement

It is recommended to create a customized measurement before selecting the
measurements (customized and factory measurements). For details, see
“Create a Customized Measurement” on page 82.

Select the Measurements

Select the data source measurements you want to use to create the Service
Report and specify their order in the report. For details, see “Select
Measurements Page” on page 158.

Example Scenario-Creating a Service Report Based on
Dashboard KPIs Data

In the Measurements Selection page, select the measurements as follows and
click Next.

Select Measurements

The Awailable Measurements area lists the measurernents relevant to the dimensions you selacted.

Mave the measurements to the Selected Measurements area,

The selection arder determines the arder the measurernents appear in the label rows or colurnns of the table (first one is the
topmaost columin header ar the far left row header).

Available Measurements: Selected Measurements:
Status Percentage(35] Event Count(#)
Status DurationChh:mrn: ss) Status Percentage(%) [Status as background)
Status Durationfhhimm: s5) (Status as background)

Ewvent Count(#) (Status as background)

4+ & 7|

Specify if the measurements should be:
% Calurnn headers ' Row headers

Clear
Click Preview to display the structure of the report. The data and
background color are for illustration purposes only.
The report with the measurements as column headers is as follows:
TimaeKange 1 Time Range2
Status Pepeentage (W) Event Count(#) S5tatus Percentage(9t) Event Count(#)
KPI1 A e 11.47 53 13.99 26
cI1 a
kP12 N @) Nadssa) 63 18.10 3¢
KPI1L 4,51 29 13,035 &5
cIz
KPIZ 19.54 2 12.41 71
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The report with the measurements as row headers is as follows:

Time Range 1 Time Range?2
§etis Percentage () 15.50
KPI1
crt Event Count(#) 52 14
Status Percentage (%) s
KPI2
Event Count(#) 47 98
v Status Percentage (2] 13.20 15.61
. Event Count(#) 26 7
Status Percentage (%) 242
KPI2
Event Count(#) 97 75

Select the Dimensions Filter

The Dimensions filter lists the dimensions you selected in the Select
Dimensions page as well as the dimensions related to the measurements you
selected in the Select Measurements page (according to the
dimensions/measurements mapping for the selected data source).

For details, see “Select the Dimension Filters” on page 161.

Example Scenario-Creating a Service Report Based on
Dashboard KPIs Data

The Mandatory Dimensions area in the Dimensions Filter page, lists the
dimensions you selected (Cl/Service), and the dimensions mapped to the

measurements you selected (Status, Time Range and KPI). Select the
appropriate filter for all the listed dimensions, and click Next.

For the CI/Service dimension, select the view and the CIs you want to
display.

Mandatory Dimensions:

Cl/Gervice

Tirne Range
View: IBuslness Services

Status

KPI

Business Services

jul

=L Ernail

I Exchange
I Lagin

1 Logout

1000

&
=
&2
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For the Time Range dimension, select Over Time.

Mandatory Dimensions:

ClfService & Suer Time 7 Time Comparison

Tirne Range Wik IWeek wdre =] 4P
Status Every: I 1 vl Idal,l(s) vl

KPI

For the Status dimension, select Critical.

Mandatory Dimensions:

Cl/Gervice
Tirne Range L ok
Status WL warning
KPI L Miner
[ n Major
& & critical
o - Mo Data
& pountime

For the KPI dimension, select Availability and Performance.

Mandatory Dimensions:

ClfService Awailability

Ui Remgs Performance
Status System
KPI Application

Bandwidth

Camponent Availability
Custornear

DT Failed Irnpact

DT Late Impack

DT Total Impact
Genetic

HP Swstern

e
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Click Preview to display the structure of the report. The data and
background color are for illustration purposes only.

4/9/2007 | 4/10/2007 4/11/2007 4/12 /2007 2

status Event Status Event Status Event Status Event

Bercentage Count Percentage Count Percentage Count Percentage Count

. ] [ 3] (i) (#) () [ 3] [¥i) (#)

E i Awailabiliiis J 12,33 17 _ 42 749 27 18.26 99

mai = |
Performarce 6,37 2 19.01 234 11.47 42 15.46 74
= Asrailability 13.40 T4 2,33 9 19.79 20 0.44 8z
Exchapde "5

Performance 5,81 72 18,57 12 14,28 42 10.70 55 (4

View the Summary

The Summary page displays the report. For details, see “Summary Page” on
page 163.

Example Scenario-Creating a Service Report Based on

Dashboard KPIs Data

In the Summary page, the Service Report displays the status and value of the
selected dimensions and measurements:

4/9/2007 4/10/2007 471172007 471272007
Status Event Status Event Status Event Status Event
Percentage Count Percentage Count Percentage Count Percentage Count
(a0) (#) (30) (#) (a0) (#) (a0) (#)

Avaiabiity |MMMMNOND 0 DMMMMNDG0 o DMMMNowo o Dllleos o
performance [UUINASOA 1o NMSaE 1o LMMssen oo LeRd0 s
Availebiity [isooss  : senen  : Lseas| - llllsesse -

Performance 1] 1] i 1]

Email

Exchange

The data displayed in the table is the correct data for the report and the
background colors represent real status.

Example-Create a Service Report for Online and for Print

If the Service Report portlet displays correctly online, but is too wide to be
printed, you can clone it. In the cloned report, you can change the location
of the dimensions or their order to create a printable report that includes the
same data as the online report.
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Create a Customized Measurement

82

You can create a customized measurement that performs an aggregation
(Average, Max, Min, Sum, Best, Worst, Count Status, or Status Percentage) or
performs a calculation (Difference, Difference by percentage, Status, or
Trend) based on selected measurement values. After you create the new
measurement, you can use it in the Service Report Builder like a regular
measurement. For details, see “New Measurement Dialog Box” on page 164.

Example Scenario-Create a Service Report Based on Dashboard
KPIs Data

To create a measurement that returns the sum of the Count(#) measurement
values, in the Select Measurements page, click the Create Measurement
button.

In the Create Measurement dialog box, enter Sum of Values in the
Measurement name box, select the Aggregated Measurement type, select
Sum in the Select function list, select Event Count(#) in the Select
measurement list, and click OK.

Enzblas you to add a caleulated or aggregated measurernent bazed an the rmeasurernents you selected in
the Seleck Measurermments page.

Measurement name: * Sum of values

Meazurernent Desctiption: |ohe measurement calculates the sum of the Event Jcount(#)

measurements,

Appears as tooltip
far the measurernent

Measurement type:  Caleulated (difference, trend, and so forth)

[ Aggregated (customn average, status, and so forth)

Selec function: * ISum ;I

Function Parameters

Select measurernent: * IEuent Countl#) ;I

The function returns the sum of the selected measurement's values,
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Example-Display the Trend Between Values

To display the trend of each instance of the time interval, access the Service
Report wizard.

In the Select Datasource page, select SLM - SLA KPI Data and click Next.

In the Select Dimensions page, move Cl/Service and SLA to the Rows box,
Calendar to the Columns box, and click Next.

In the Select Measurement page, click the Create Measurement button.

In the Create Measurement dialog box, enter Trend on time interval in the
Measurement name box, select the Calculated Measurement type, select
Trend in the Select function list, select Calendar (column’s header) in the
Select Dimension list, KPI Value (Time Interval 1) in the First Measurement
list, and KPI Value (Time Interval 2) in the Second Measurement list in the
Function Parameters area, and click OK.

In the Select Measurement page, click Preview. The preview displays the
trend of the SLAs between two time intervals.

TIL TI2 Trend on time interval
CI1 0.61 4,42 W
SLA1
[ ] 12,93 8,81 &
CI1 0,28 1,49 ¥
SLAZ
CI2 11.73 8,59

You can then adjust the appropriate dimension filters and save the report.

Example-Display How Far an SLA is From Exceeding Its Target

To display how far the SLA is from exceeding its target, access the Service
Report wizard.

In the Select Data source page, select SLM - SLA KPI Data and click Next.

In the Select Dimensions page, move Cl/Service and SLA to the Rows box,
Calendar to the Columns box, and click Next.

In the Select Measurement page, click the Create Measurement button.
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In the Create Measurement dialog box, enter Diff value from target in the
Measurement name box, select the Calculated Measurement type, select
Difference by percentage in the Select function list, select SLA (row headers)
in the Select Dimension list, KPI Value (SLA 1) in the First Measurement list,
and Targets - Exceeded (SLA 2) in the Second Measurement list in the
Function Parameters area, and click OK.

In the Select Measurement page, click Preview. The preview displays the
structure of the report that shows how far the SLA is from the exceeded

value in percentages.

TI1 TIZ
CI1 -28.44 -41.16

SLA1
CI2 160,27 -88.61
CI1 097,17 -32.15

S5LAZ
CI2 -93.68 -62.44

You can also display the measurements on which you base the calculation:

TI1 TIZ
¥alue  Targets - Exceeded Diff value from target  Walue Targets - Exceeded Diff value from target
cI1 3,47 7,99 -27.35 1.29 12,18 -89.43
SLAL cIz &6.20 15.59 -56.37 11.77 14.24 -20.71
CI1 2.18 3.26 151.05 15.81 J.EE 105.77
sLaz CI2 | 12.55 1.11 1.034.635 8.66 14,72 -41.20

You can then select the appropriate dimension filters and save the report.

Example-Fine-Tune SLAs

Instead of adjusting the SLA thresholds in the Service Level Management
application directly, create a Service Report based on the appropriate Service
Level Management data sources and create a new measurement based on the
Status function. Fine-tune the function thresholds to check the SLA over a
specific time-period until you get the required results. You can then use
those thresholds in the Service Level Management application.
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Example-Drill Into SLAs Data

The smallest status duration for an SLA is five minutes. If a customer has
multiple SLAs and you want to see when the objective exceeds 98 you can
create a Service Report with the Status function, and set the threshold to 98.
The report displays the status information and not the real SLA
measurement. The tooltip displays the real name of the calculated
measurement.

Example-Simulate a Tracking Period That Starts and Ends on
Mondays

Usually the tracking period is from the first day of the previous month/week
to the first day of the month/week. To create a report that provides
information from the third day (Monday) of the previous month/week to
the third day of the month/week, access the Service Report wizard.

In the Select Datasource page, select SLM - SLA KPI Data and click Next.

In the Select Dimensions page, move Cl/Service to the Rows box, SLA to the
Columns box, and click Next.

In the Select Measurement page, click Create Measurement.

In the Create Measurement dialog box, enter My Average Value in the
Measurement name box, select the Aggregated Measurement type, select
Average in the Select function list, select KPI Value in the Select
measurement list, and click OK.

In the Select Measurement page, the My Average Value measurement is
automatically moved to the Selected Measurements box. Click Next.

In the Select Dimension Filters page:
» For the Cl Mandatory Dimension, select a view, and the appropriate CIs.

» For the SLA Mandatory Dimension, select SLAs 1 and 2.

» For the Time Ranges Mandatory Dimension, select Over Time, Week
where you select the date to be from the 3rd day to the 3rd day and Every
day. The hour is automatically changed to midnight.
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» For the KPIs Mandatory Dimension, select Availability and Performance.
» For the Calendar Mandatory Dimension, select 24x7.

Click Finish, OK, and Save.

Open My BAC and display the report.

) Service Report 2]zl gl
il
SLA1 S5LA2
Finance Service 79,20 80,17
HR Service 79.20 80,17
T Click the funnel button to display the report filter. It indicates that the

report starts and ends on Mondays.

Service Report
w

Calendar: 24x7
KPI: Availability , Performance
Selected Time: 2/12/07 12:00 AM - 2/15/07 10:42 PM Arnericaflos Angeles Euary 1 Dayl=)

Measurement: My Average Value
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Measurements Map

The dimensions and measurements map for the SLA KPI data source
includes the following elements:

Dimensions and measurements mapping for the
Service Level Management — SLA KPI data

l:l meaasurement
group

KF| Value
KPI Status
Additional Values
Deviation From Target, Deviation From Target (%)
# of Samples/ Successes!FailuresiTrimmed Samples/Met Thresholds
Standard Deviation
DPMO

Targets — AllBreachad!

ExceededMet/
Minor Breached

Depending on the dimensions and measurements you select, make either a
single selection or multiple selection for each dimension’s values. For

details, see “Impact on the Type of Selection: Single Selection or Multiple

Selection” on page 66.

The dimensions are (listed alphabetically):

GUI Element

Description

Calendar

Select one of the following business-day structures:

» 24hx7d
» Business Hours

Cl/Service

The CI or business service.
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GUI Element Description

KPI Select the CI's KPIs you want to display in the report.
SLA The Service Level Agreement.

Time Range The time range for which you want to see information.

The measurements are (listed alphabetically):

GUI Element

Description

Additional Values

Select to display all the enabled additional
measurements in the report. For details about
additional values, see “Additional Values in Reports” in
Using Service Level Management.

Note: To modify the default list of enabled additional
values displayed per KPI, select Admin > Platform >
Setup and Maintenance > Infrastructure Settings,
choose Applications, select Service Level Management,
and locate the Additional Values entry in the Service
Level Management - SLM Admin table. Set the value to
true for a KPI and an additional value when you want
to display that additional value parameter for the KPI.
If an additional value is not included for a specific KP],
it is not available for that KPI. The PNR KPI appears in
the Additional Values settings for internal purposes. Do
not modify it.

KPI Status

Displays the status of the KPI, CI, and SLA that
characterize the cell.

KPI Status (as text
and background)

Displays the status and the status compared to the
objective as a colored background in the report cell.

KPI Status as
background

Displays the status compared to the objective as a
colored background in the report cell.

KPI Value

Displays the value the status of the KPI, CI, and SLA
that characterize the cell is based on.

KPI Value (KPI Status
as background)

Displays the value and the KPI status as a colored
background in the report cell. The KPI status is
calculated according to the objectives.
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GUI Element Description

Targets - All Displays the percentage of time the value of the
selected KPI was in the range defined for all targets.

Targets - Breached Displays the percentage of time the value of the
selected KPI was in the range defined for the Breached
target.

Targets - Exceeded Displays the percentage of time the value of the
selected KPI was in the range defined for the Exceeded
target.

Targets - Met Displays the percentage of time the value of the
selected KPI was in the range defined for the Met
target.

Targets - Minor Displays the percentage of time the value of the

Breached selected KPI was in the range defined for the Minor
Breached target.
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Service Level Management - SLA Status Data Dimensions
and Measurements Map

The dimensions and measurements map for the SLA Status data source
includes the following elements:

Dimensions and measurements mapping for the
Service Level Management — SLA Status Data

data source
Legend:
ofecasi Based on . .
e ey SLA SLA Overall Status () dimension
maasuremsant
L1 group

SLA Forecast Status Time Ran
SLA Breached Date Ime ~Range

Tracking
Period

SLA Historical
Status

SLA Status

Depending on the dimensions and measurements you select, make either a
single selection or multiple selection for each dimension’s values. For
details, see “Impact on the Type of Selection: Single Selection or Multiple
Selection” on page 66.
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The dimensions are (listed alphabetically):

GUI Element

Description

Forecast Based On
Tracking Period

The forecast calculated for the analysis period based on
the assumption that the SLA will perform in the future
as it did during this analysis period.

SLA

Select one or more of the available SLAs that are
defined for your site.

For details on single or multiple selection, see “Impact
on the Type of Selection: Single Selection or Multiple
Selection” on page 66.

Time Range

The time range for which you want to see information.

Tracking Period

The tracking periods that are used to track agreement
status and compile data. The tracking periods define
the granularity available in Service Level Management
reports.

The measurements are (listed alphabetically):

GUI Element

Description

Forecast Status (as
text and
background)

Displays the status of the forecast with the Forecast
Status status compared to the objective as a colored
background in the report cell.

SLA Breached Date

Displays the SLA breached date from the forecast
report.

SLA Forecast Status

Displays the status of the forecast.

SLA Forecast Status
as background

Displays the status of the forecast compared to the
objective as a colored background in the report cell.

SLA Historical Status

Displays the historical status for the selected time
range.

SLA Historical Status
(as text and
background)

Displays the value of the Historical Status with the
Status status compared to the objective as a colored
background in the report cell.
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GUI Element

Description

SLA Historical Status
as background

Displays the Historical Status status compared to the
objective as a colored background in the report cell.

SLA Overall Status

Displays the status used to compare to the forecast for a
selected SLA and selected time range.

SLA Overall Status
(as text and
background)

Displays the value of the Overall Status with the Status
status compared to the objective as a colored
background in the report cell.

SLA Overall Status as
background

Displays the status of the Overall Status compared to
the objective as a colored background in the report cell.

SLA Status

The current status of the SLA for the selected time
range.

SLA Status (as text
and background)

Displays the value of the Status with the status
compared to the objective as a colored background in
the report cell.

SLA Status as
background

Displays the Status status compared to the objective as
a colored background in the report cell.

Time Comparison

Enter a label for the dimension in the Label box.

Select the tracking range and granularity for the report.
For details, see “Choosing the Time Range and
Granularity” in Reference Information.
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Dashboard KPIs Data Source Dimensions and Measurements

The dimensions and measurements map for the Dashboard KPIs data source
includes the following elements:

Dimensions and Measurements Mapping for the

CliService

Status

Dashboard KPIs data source

Legend:

D dimension
l:l measurament

KPI group

Event Count
Status Percentage
Status Duration

Depending on the dimensions and measurements you select, make either a
single selection or multiple selection for each dimension’s values. For

details, see “Impact on the Type of Selection: Single Selection or Multiple

Selection” on page 66.

The dimensions are (listed alphabetically):

GUI Element

Description

Cl/Service

The configuration item or service.

KPI

The CI's KPIs you want to display in the report.

Status

The status of the KPI.

Time Range

The time range for which you want to see information.
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The measurements are (listed alphabetically):

GUI Element

Description

Event Count (#)

Displays the number of events with the selected status
that occurred in. the selected time range.

Event Count (#)
(Status as
background)

Displays the value of the Event Count with the Status
as a colored background in the report cell. The Status
represents the status dimension instance (OK, FAILED,
and so on)

Status Duration
(hh:mm:ss)

Displays the length of time in hours, minutes, and
seconds, during which the KPI had the selected status.

Status Duration
(hh:mm:ss) (Status
as background)

Displays the value of the Status Duration with the
Status status compared to the objective as a colored
background in the report cell.

Status Percentage
(%)

Displays the length of time during which the KPI had
the selected status divided by the selected time range in
percentage.

Status Percentage
(%) (Status as
background)

Displays the value of the Status Percentage with the
Status status compared to the objective as a colored
background in the report cell.
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Over Time Additional Data Dimensions and Measurements
Map

The dimensions and measurements map for the Over Time Additional Data
data source includes the following elements:

Dimensions and Measurements Mapping for the
Over Time Additional Data data source

CliService

I:I measurement

group

Mumber of Tickets Mumber of Users

Depending on the dimensions and measurements you select, make either a
single selection or multiple selection for each dimension’s values. For

details, see “Impact on the Type of Selection: Single Selection or Multiple
Selection” on page 66.

The dimensions are (listed alphabetically):

GUI Element Description
Cl/Service The configuration item or service.
Time Range The time range for which you want to see information.
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The measurements are (listed alphabetically):

GUI Element Description

# of tickets Displays the number of tickets (open incidents) that
were opened with the selected severity during the
selected time period.

To specify the severity, you must first specify the rule
that is used to calculate the number of tickets.

To specify the rule, select Admin > Platform > Setup
and Maintenance > Infrastructure Settings, choose
Applications, select Dashboard Application, and locate
the Number of open Incidents rule entry in the
Dashboard Application - Service Impact table. Enter the
value of the rule you want to use. A list of rules and
rule numbers are available in the Repositories (to access
the Repositories, select Admin > Dashboard >
Repositories > Business Rules.

To specify the severity you want to use, edit the rule’s
properties in the Repositories.

# of users Displays the number of users, calculated by Real User
Monitor, using the specified CI/Service during the
selected time period.

Troubleshooting and Limitations

This section includes the Service Report troubleshooting and limitations.

When creating a Service Report, the following limitations apply:

» Itis not recommended to move two or more than two elements in the Rows
box, and none to the Columns box in the Select Dimensions page, or vice-
versa. It is recommended to move at least one element in the Columns box
and one in the Rows box.

» If you are editing a Service Report and you change the data source of the
report, you cannot perform a Clear operation in the Select Dimensions or
the Select Measurement page. Clicking Clear issues an error message.
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» When you select measurements from different measurement groups, the
order of the measurements in the report and in the preview is different from
the selected order. For example: if you select: Value, Targets - All, and Status,
the order of the measurements in the report is: Value, Status, Targets - All.
For details about the measurement groups, see the maps described in “Select
Dimensions Page” on page 155.

» If you select all the available dimensions in the Select Dimensions page, you
cannot create a new aggregated measurement. For details about creating
aggregated measurements, see “New Measurement Dialog Box” on page 164

> You cannot create a measurement that already exists and give it a different
name.

» You cannot create different measurements with the same name.

» [t is not recommended to create a calculated measurement whose
dimensions appear in both the Rows and Columns boxes in the Select
Dimensions page. For example, if you create a Diff calculated measurement
based on the KPI Value and the Targets - Met measurements, the Cl, SLA,
and KPI dimensions participate in the calculation. It is recommended to
move at least one of those dimensions in the Rows box if the other
dimensions are in the Column box or vice-versa, so the report has the
following structure:

CI/Service 1 CI/Service?
Time Range 1 3,17 -8.35
KPI1
Time Range2 4.75 -0.57
SLA1
Time Range 1 4,79 -16.64
KPLe
Time Range2 5,36 -17.98
Time Range 1 -8.00 6,10
KPI1
Time Range2 -0.65 0,32
SLAZ
Time Range 1 -3.87 9.05
KPIZ
Time Range2 15.91 15.57

» You cannot combine in a report an aggregated measurement with calculated
measurements, or an aggregated measurement with regular measurements.

» In the Select Dimension Filters page, the automatic preview is activated only
after you move to another dimension in the Mandatory Dimensions list.
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> In the Select Dimension Filters page, the automatic preview displays an error
message even when you have selected Cls. Click the Preview button or
move to another dimension in the Mandatory Dimensions list to activate
the preview feature.
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3

My BAC User Interface

This chapter includes the pages and dialog boxes that are used to create a

module.

This chapter describes: On page:
Add Portlets to <page_name>/Add Portlets Dialog Box 102
Add Preconfigured Pages Dialog Box 103
Add a User’s Pages to Module Dialog Box 104
Advanced Options Dialog Box 105
Configure Modules Dialog Box 105
Configure <module_name> Dialog Box 107
Configure Portlet Definitions Dialog Box 114
Create Module Dialog Box 120
Create WSRP URL Dialog Box 121
Edit Group Dialog Box 123
Edit Page Dialog Box 124
Edit Preferences <portlet_name> Dialog Box 127
Export My BAC Obijects Dialog Box 132
Import My BAC Objects Dialog Box 134
Import Portlet Definition Wizard 135
Manage Categories Dialog Box 143
Manage Modules Tab 144
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This chapter describes: On page:
Manage Portlet Definitions Tab 145
My BAC Page 146
Page Rotation Dialog Box 149
Portlet Privilege Dialog Box 150
Users or Groups Dialog Box 151

Add Portlets to <page_name>/Add Portlets Dialog Box

Description

Enables you to add portlets to a page.
To Access:
» Select My BAC, display the page to which you want

to add the portlet, and click Add Portlets to open
the Add Portlets to Page dialog box.

» In My BAC Admin, in the Edit page dialog box, click
Add Portlets.

Included in Tasks

» “Add Portlets to a Page” on page 25
» “Manage the Portlets in Your Portal” on page 28.

Useful Links

“Naming Conventions” in Reference Information

Search for Portlets to Add Area

The area includes the following elements (listed alphabetically):

GUI Element

Description

Category

Enter the portlet category. Leave the boxes empty to
find all portlets.

Find Portlets

Click to list the portlets answering the query (and for
which you have access rights).

Portlet Name

Entering the portlet name. Leave the boxes empty to
find all portlets.
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Select Portlets to Add Area

The area includes the following elements (listed alphabetically):

GUI Element

Description

7]

Click to access the online help for the corresponding
report in the application.

<check box>

Click to select the portlet to be added to the page.

Add Click to add the selected portlet to the page.
Category The portlet category.

Description The description of the portlet.

Find Portlets Click to list the portlets answering the query (and for

which you have access rights).

Portlet Name

The name of the portlet.

Add Preconfigured Pages Dialog Box

Description

Enables you to add preconfigured pages to My BAC.

Pre-configured modules or pages are optional. The user
can copy them to his private My BAC dashboard area.
They are not listed in the shared area.

To Access: In Personalize My BAC, click the Add
Preconfigured Pages button.

Important
Information

Select the relevant modules.

Included in Tasks

“Add Pages or User’s Pages to a Module” on page 24
“Add Pages to Your Portal” on page 27
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Add a User’s Pages to Module Dialog Box

Description

Enables you to add another user’s pages to the
module.

To Access: Click Add a User’s Pages in the Create
Module page or click icon in tree.

Included in Tasks

“Add Pages or User’s Pages to a Module” on page 24

The dialog box includes the following elements (listed alphabetically):

GUI Element

Description

al

Click to choose the users who will have self-service
access to the module. For details, see “Users or Groups
Dialog Box” on page 151

Click to choose the groups of users who will have self-

& service access to the module. For details, see “Users or
Groups Dialog Box” on page 151
Add Click to save the changes.
Pages Select the user’s pages.

Replace pages in
module with
matching names

Select to overwrite the existing pages in the module
with the user’s pages that have the same name.

Clear the check box to add the selected page without
replacing existing pages.

User

Select the user.
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Advanced Options Dialog Box

Description Displays a subset of the description options that can be
added to the portlet. Select the required options and
click OK to save the changes.

To Access: Click Advanced Option in the Edit
Preferences page.

Important This dialog box and the button used to access it are
Information available only for Service Level Management portlets.
Included in Tasks “Edit/Customize a Portlet” on page 26

“Manage the Portlets in Your Portal” on page 28

The dialog box includes the following elements (listed alphabetically):

GUI Element Description

<options> Select the descriptions you want to add to reports to
appear below the report data. Descriptions are
displayed in all reports. For details about the options,
see “Setting Number of Digits in Results” in Using
Service Level Management.

Configure Modules Dialog Box

Description Enables you to search for an existing module whose
pages, portlets, access, and layout, you want to modify.

To Access: In My BAC Administration, click the
Manage Modules tab, and select Configure Modules.

Important See limitations in “Troubleshooting and Limitations”
Information on page 96.

Included in Tasks “Create a Module” on page 21

Useful Links “Naming Conventions” in Reference Information
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Search for a Module to Configure Area

The area includes the following elements (listed alphabetically):

GUI Element

Description

Click to display the list of all the users and select from
the list. For details, see “Users or Groups Dialog Box”
on page 151.

Click to display a calendar and select a date. For details,
see “Users or Groups Dialog Box” on page 151.

Click to display the list of all the users and select from
the list. For details, see “Users or Groups Dialog Box”
on page 151.

Click to display the list of all the groups or users and

= select from the list. For details, see “Users or Groups
Dialog Box” on page 151.
Ascending/ Select the type of sorting.
Descending

Available to Users...
Groups

Enter the name of users or groups of users who are
allowed to use the module.

Created By

Enter the name of the user who created the module.

Last Updated From..
To

Enter the date from when to start the search and when
to end it.

Name starts with

Enter the first letters of the module name.

Keep the box empty if you want to list all the existing
modules.

Reset Form

Click to empty all the fields in the form.

Results Displayed Per
Page

Enter the number of results to display per page.

Note: The limit is the number of portlets that have
been imported into My BAC.

Search

When you click the button, a list of the modules
matching the search criteria is displayed. Click the
appropriate module to configure it. For details, see
“Configure <module_name> Dialog Box” on page 107.
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GUI Element Description

Sort By Select by which criteria to list the modules matching
the search criteria: Name, Last Updated On, or Status.

Status Enter the status of the module.

Configure <module_name> Dialog Box

Description Enables you to create a new module, configure a
module, add comments, and configure access to the
module.

To Access: Double-click the appropriate module in the

Configure Module page.
Important The page is split into two main panes: the tree of
Information modules and the dialog box. For details, see

“Module/Page Tree” on page 17.

Note: When a new user is added to a group, the
modules assigned to the group and their permissions
are automatically passed on to the new user.

Included in Tasks “Create a Module” on page 21

“Configure Access to the Module” on page 24

Tree of Pages area

The area includes the following elements (listed alphabetically):

GUI Element Description

O Click to close or open the tree.

<context menu Right-click an element in the left-pane tree to display
options from the the context menu options. For details, see “Context
elements in the tree> | Menu Options and Toolbar Icons” on page 108.
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GUI Element Description

<toolbar icons> Select an element in the left-pane tree and click the
appropriate toolbar icon. For details, see “Context
Menu Options and Toolbar Icons” on page 108.

<tree of module> Displays the currently selected module, its pages, and
portlets.

Context Menu Options and Toolbar Icons

The context menu options and toolbar icons includes the following
elements (listed alphabetically):

GUI Element Description
| To add a new page or a user page to the module, right-
L+ ™ click a module, select the option or select a module,
click the icon and select:
Add
» New Page to add a blank page. For details, see
“Edit Page Dialog Box” on page 124.
» Add User Page to add a user page. For details, see
“Add a User’s Pages to Module Dialog Box” on
page 104.
- Click to return to the Create Module page.
Back
. To clone a module, right-click the module and select
0=0 . . .
the option, or select a module in the tree and click the
button. A copy of the module is pasted in the tree and
Clone the original module is disabled.
= To copy a page, right-click the page and select the
option or select the page in the tree and click the
button.
Copy
To copy a portlet, right-click the portlet and select the
option or select the page in the tree and click the
button.
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GUI Element

Description

x|

Delete

To delete a module, right-click the module and select
the option, or select the module in the tree, and click
the button. You must also confirm the deletion.

To delete a page in the tree, right-click the page and
select Delete, or select the page, and click the button.
You must also confirm the deletion.

To delete a portlet in the tree, right-click the portlet
and select Delete, or select the portlet, and click the
button. You must also confirm the deletion.

Edit

To edit a module, right-click the module and select the
option. For details, “Configure <module_name> Dialog
Box” on page 107.

To edit a page, right-click the page and select the
option. For details, see “Edit Page Dialog Box” on
page 124. You can then add portlets to the page or
delete them from the page.To edit a portlet, right-click
the portlet and select the option. For details, see “Edit
Preferences <portlet_name> Dialog Box” on page 127.

Paste

After you have selected a page and copied it, right-click
the module where you want to paste the page and
select Paste, or click the module where you want to
paste the page, and click the button.

After you have selected a portlet and copied it, right-
click the page where you want to paste it and select
Paste, or click the page where you want to paste the
portlet, and click the button.

To reorder the pages of a module, right-click the page
and select Up or Down, or select a page in the module,
and use the Up and Down buttons.

Up/Down

ﬂ To display a preview of the page that includes real data,
right-click the page and select View or select a page and
click the button.

View

To display a preview of the portlet that includes real
data, right-click the portlet and select View or select a
portlet and click the button.
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Header Area

The area includes the following elements (listed alphabetically):

GUI Element Description

Created By The name of the user who created the module.
Description Enter a brief description of the module.
Enabled To enable the module, select Yes.

To disable the module, select No.

Default Value: Yes. The module is available for adding
to users’ portals.

Note: If you disable a module after it has been made
available, the module is removed from the users shared
area and a warning message is issued. The module
pages are not removed from the users private area.

Last Modification
Date

The date the module was last modified.

Last Modified By

The name of the user who last modified the module.

Module Name

Enter the name of the module. This name must be
unique.

Administrator Comments Area

Description

Enables you to add administrator comments to the
module.

To Access: Expand the Administrator Comments.

Important
Information

The comments are displayed in the <module_name>
Comments page. If you add a comment to the module,
it counts as a change and the orange square indicating
a change is displayed in the Switch to page menu.
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The area includes the following elements (listed alphabetically):

GUI Element Description

Add Comment Enter the comments.

View Comments Click to display the Module Comments page with the
comments you entered.

Configure Access Area

The area includes the following elements (listed alphabetically):

Description Enables you to configure access to the module:

» Read-only access for the selected users/groups. For
details, see “User Access Area” on page 111.

» Modify access for the selected users/groups. For
details, see “Administrator Access Area” on
page 112.

» Add access for the selected users who can add the
module to their My BAC portals as preconfigured
pages. For details, see “Self-Service Access Area” on
page 113.

To Access: Expand the Administrator Comments.

Important For details about the type of access to the module, see
Information “Types of Access” on page 42.

User Access Area

The area includes the following elements (listed alphabetically):

GUI Element Description

ﬂ Click to choose the users with read-only access to the
module. For details, see “Users or Groups Dialog Box”
on page 151.

Click to choose the groups of users with read-only
access to the module. For details, see “Users or Groups
Dialog Box” on page 151.
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GUI Element

Description

Add Users

Select User or Group.

Note: You must select at least one user or one group of
users.

Allow access to all
users

Select to provide read-only access to the module to all
the users.

Enable users to copy
this module pages to
their private

Select to enable the users selected above in the User
Access area to copy the module pages to their private
My BAC dashboards.

dashboard

Name Displays the name of the user or group of users.

Type Displays the type (users or groups of users).
Administrator Access Area

Important This area is for future use.

Information

Currently, users with the administrator permission can
modify all modules, all the module pages, and all the
portlets on the pages.

For details about the permissions and where to set
them, see “User Management Overview” in Platform
Administration.

The area includes the following elements (listed alphabetically):

GUI Element

Description

&)

Click to choose the users with self-service access to the
module. For details, see “Users or Groups Dialog Box”
on page 151.

Note: You must select at least one user or one group.

Click to choose the groups of users with self-service
access to the module. For details, see “Users or Groups
Dialog Box” on page 151.

Note: You must select at least one user or one group.
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GUI Element

Description

Add

Click to add the selected users or groups.

Give access to

Select User or Group.

Name

Displays the name of the user or group of users.

Type

Displays the type (users or groups of users).

Self-Service Access Area

The area includes the following elements (listed alphabetically):

GUI Element

Description

&)

Click to choose the users who will have self-service
access to the module. For details, see “Users or Groups
Dialog Box” on page 151

Click to choose the groups who will have self-service

= access to the module. For details, see “Users or Groups
Dialog Box” on page 151
Add Click to add the selected users or groups.

Allow users to add
this module to their
My BAC portals as
preconfigured pages

Select to provide the users selected above in the Self-
Service access area to add the module to their My BAC
portals as preconfigured pages.

Preconfigured modules or pages are optional. The user
can copy them to the Private Pages area in My BAC
dashboard. They are not listed in the shared area.

Give access to

Select User or Group.

Note: You must select at least one user or group.

Name

Displays the name of the user or group of users.

Type

Displays the type (users or groups of users).
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Configure Portlet Definitions Dialog Box
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Description

Enables you to edit, copy, or delete portlet definitions.

To Access: Select Admin > My BAC > Manage Portlet
Definitions > Configure Portlet Definition, and click
Configure Portlet Definition.

Included in Tasks

“Configure a Portlet Definition” on page 19

Useful Links

“Naming Conventions” in Reference Information

Searching for a Po

rtlet Definition to Configure Area

Description

Enables you to search for the portlet definition you
want to edit, copy, or delete.

The area includes the following elements (listed alphabetically):

GUI Element

Description

|

Click to select the category.

Click to select the user.

Ascending/
Descending

Select the sort order for results as ascending or
descending. The default is ascending.

Category Select a category to find only those portlet definitions
that belong to that category.

Created By The name of the user who created the portlet
definition.

Enabled Select:

> Yes (the default) to enable the portlet to be added to
a page.

» No. To prevent the portlet to be added to a page. You
might use this option in a testing environment.

Name starts with

Type all or part of a portlet definition’s name. Typing
part of a name yields all matching results.




Chapter 3 « My BAC User Interface

GUI Element

Description

Reset Form

Click this button to clear all the fields and display
default criteria.

Results Displayed Per
Page

Enter the number of search results to display on every
page. The default is 50. This field is mandatory.

Search Click to start the search.

Sort By To sort results, select either Name, Type, Category, or
Enabled.

Type Select the type of portlet: Java or WSRP.

Configure Portlet Definition Area (List of Portlets)

Description Enables you to select the portlets you want to
configure.

Important Click the name of a portlet to open its configuration

Information details.

The area includes the following elements (listed alphabetically):

GUI Element Description

Category The portlet category.

Description A description of the portlet.

Enabled Select:
» Yes if the portlet is enabled to be added to a page.
» No if the portlet is not available to be added to a

page.

Name The name of the portlet.
Click the name of the portlet to open the Configure
Portlet Definition page for the selected portlet.

Prev/Next To navigate the search results.

Type The type of portlet: Java or WSRP.
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Configure Portlet Definition Area

Description

Enables you to change the name of the portlet, its
category, its display mode, and to enable or disable it.

The area includes the following elements (listed alphabetically):

GUI Element Description

Category The portlet category. A category helps users find the
portlets they need.

Copy To create a new portlet definition with similar
properties as the current portlet definition.
Click to open the Copy Portlet Definition page. The
page is the same as the Configure Portlet Definition
area. Make the changes. For details, see “Configure
Portlet Definition Area” on page 116.

Created By The name of the user who created the portlet.

Default Width Select Wide or Narrow default portlet width. System
default is Narrow.

Delete Click to delete the portlet definition and confirm the
deletion.

Description A description of the portlet.

Enabled Select:

» Yes if the portlet is enabled to be added to a page.
» No if the portlet is not available to be added to a
page.

Last Modification
Date

The date the portlet definition was last modified.

Last Modified By

The name of the user who last modified the portlet
definition.

Manage Categories

Click the Manage Categories button to add or delete
portlet categories. For details, see “Manage Categories
Dialog Box” on page 143.

Name

Enter the name of the portlet.
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GUI Element Description

Portlet Display Name | The name of the portlet that is displayed in the page.

Portlet Type The type of portlet: Java or WSRP.
Prev/Next To navigate the search results.
View Usage Displays a list of the users, modules, or hyperlinks that

reference the portlet. This is information that you want
to take into consideration when you want to disable a
portlet or to modify its definition.

Configure Access Area

Description Enables you to configure access to the portlet:

» Selected users/groups can add the portlet to their
pages. For details, see “User Access Area” on
page 118.

» Selected users/groups have modify access to this
portlet. For details, see “Administrator Access Area”
on page 119.

» WSRP consumers can consume the portlet from a
remote portal. For details, see “WSRP Access Area”

on page 119.
To Access: Expand Configuration Access.
Important For details about the type of access to the module, see
Information “Types of Access” on page 42.
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User Access Area

Description

Enables you to specify the users or groups who can add
the portlet to their private My BAC dashboards.

The area includes the following elements (listed alphabetically):

GUI Element

Description

o

» Click the icon close to the Require users to have one
of these privileges box to select the appropriate
privilege. For details, see “Portlet Privilege Dialog
Box” on page 150.

» Click the icon close to the Give access to box to
choose the groups who will have user access to the
module. For details, see “Users or Groups Dialog
Box” on page 151.

Note: You must select at least one user or one group.

&)

Click to choose the users with user access to the
module. For details, see “Users or Groups Dialog Box”
on page 151.

Note: You must select at least one user or one group.

Add

Click to add the selected users or groups.

Allow access to only
the following users
and groups

Displays the selected users and groups.

Give access to

Select User or Group.

Require users to have
one of these
privileges

Displays the name of the privilege needed to add the
portlet to private pages.
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Administrator Access Area

Description

Enables you to select the users or groups who can
modify the portlet definition.

The area includes the following elements (listed alphabetically):

GUI Element

Description

&)

Click to choose the users with administrator access to
the portlet. For details, see “Users or Groups Dialog
Box” on page 151.

Note: You must select at least one user or group.

Click to choose the groups with administrator access to

= the portlet. For details, see “Users or Groups Dialog
Box” on page 151.
Note: You must select at least one user or group.
Add Click to add the selected users or groups of users.

Give access to

Select User or Group.

Name

Displays the name of the user or group of users.

Type

Displays the type (users or groups of users).

WSRP Access Area

Description

Enables you to select to make the portlet available to
WSRP consumers. This means, that the portlet can be
consumed from a remote portal.

The area includes the following elements (listed alphabetically):

GUI Element Description

Make Portlet Select to make the portlet available to WSRP
Available to WSRP consumers.

Consumers

Default: Make Portlet available to WSRP Consumers is
set for all Dashboard portlets.
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Create Module Dialog Box

Description

Enables you to create a module, its pages, and the
portlets in the pages, in a tree format. You can give
sharing access to that module, add comments, and edit
the portlets and their layouts.

To Access: In My BAC Administration, select Create
Modules in the Manage Modules tab.

Included in Tasks

“Create a Module” on page 21

The page includes the following elements (listed alphabetically):

GUI Element Description

Create Click to create open the Create <module_name> dialog
box where you can add details about the module.

Description Enter a description of the module.

Enable To enable the module, select Yes.

To disable the module, select No.

Default Value: Yes. The module is available for adding
to users’ portals.

Note: If you disable a module after it has been made
available, the module is removed from the users shared
area and a warning message is issued. The module
pages are not removed from the users private area.

Module Name

Enter the name of the module.
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Create WSRP URL Dialog Box

Description Enables you to create a WSRP URL when you want to
export portlets from My BAC to a remote portal.

To Access: Select Admin > My BAC > Manage Portlet
Definitions > Create Secured WSDL.

Important The URL can be used with or without user credentials.
Information For details, see “Use an Authenticated WSRP URL” on
page 33.

Note to HP Managed Software Solution customers:
Pre-authenticated WSRL URL is supported in HP
Managed Software Solution, and customers have their
own producers. The logon user name, and password
must be embedded in the URL. The customer ID is
automatically embedded in the URL. The portlet
definitions are those of the specific customer ID. When
reentering the portlet, the user is logged on
automatically.

Included in Tasks “Pre-Authenticated WSRP URLs” on page 18

The page includes the following elements (listed alphabetically):

GUI Element Description

Authenticate with Select to use a non-authenticated URL to access the

user from WSRP WSRP portlet. You must define a consumer user as one

consumer of the users in HP Business Availability Center. For
details, see “Use an Authenticated WSRP URL” on
page 33.

Automatically Select to use an automatically authenticated

authenticate with the | authenticated URL to access the WSRP portlet. For

following credentials | details, see “Use an Authenticated WSRP URL” on
page 33.
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GUI Element

Description

Copy

Click to highlight the contents of the Use this URL for
WSRP box and to automatically copy this information
to the clipboard. You can then copy the URL where
needed.

Note: In Mozilla Firefox, you must manually copy the
contents to the clipboard.

Create

Enter a user name and password, and then click to
create the URL. The default URL in the Use this URL for
WSRP box is modified to include the user name and
password, as follows:

http://<server_name>/dashboard/wsrp4jproducer.wsd|?
dsh_username=<user_name>&dsh_password=
<password>&dsh_customer=<dsh_customer>

Copy the URL to access a My BAC portlet from another
portal or to import a portlet from another My BAC
machine, with authentication.

Note:

» <user_name> and <password> are encrypted.

» <dsh_customer> is automatically inserted. It is not
encrypted and represents your Customer ID. Do not
modify it!

Password

Enter the logon password if you are using an
automatically authenticated URL.

For details, see “Use an Authenticated WSRP URL” on
page 33.

Use this URL for
WSRP

Displays the default URL or the URL you created by
clicking the Create button.

User name

Enter the logon user name. if you have selected to use
an automatically authenticated URL.

For details, see “Use an Authenticated WSRP URL” on
page 33.
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Edit Group Dialog Box

Description Enables you to group pages.You can then add pages to
the group.

To Access: Select the Private Pages root and click the
New Group button in the user’s modules tree.

Important You cannot create a group of pages under another
Information group of pages.
Included in Tasks “Create Users and Groups” on page 21

The dialog box includes the following elements (listed alphabetically):

GUI Element Description
Description The description of the group of pages.
Group name The name of the group of pages.
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Edit Page Dialog Box
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Description Enables you to manage pages, portlets, and user pages.
To Access:

» In My BAC, click the Personalize button E
» In My BAC Admin, in the Configure Module page:

» Select the module in the tree and click the New
Page button [ |.

» Right-click the module in the tree and select New

Page.
» Right-click a page in the tree and select Edit.
Important The page is split into two main panes: the tree of pages
Information and the dialog box. The left pane is split into the

Private Pages area and the Shared Pages area. For
details, see “Module/Page Tree” on page 17.

Note: When a new user is added to a group, the
modules assigned to the group and their permissions
are automatically passed on to the new user.

Included in Tasks “Personalize Your My BAC Portal” on page 27

Useful Links “Naming Conventions” in Reference Information

Tree of Pages area

The area includes the following elements (listed alphabetically):

GUI Element Description
O Click to expand or collapse the left pane.
a This icon appears in the Shared Pages area of the tree

in My BAC for modules or pages that can only be
viewed (you cannot copy them or modify them).

<context menu Right-click an element in the left pane to display the
options from the context menu options. For details, see “Context Menu

elements in the tree> | Options and Toolbar Icons” on page 108.
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GUI Element

Description

<toolbar icons>

Select an element in the left pane and click the
appropriate toolbar icon. For details, see “Context
Menu Options and Toolbar Icons” on page 108.

<tree of pages>

Displays:

» The Private Pages root and under that, the pages and
portlets of the user.

» The Shared Pages root and under that the pages and
portlets of the modules created by the administrator.

» The built-in Default Module. For details, see “Java
and WSRP Portlets” on page 16.

Context Menu Options or Toolbar Icons

GUI Element Description
: To add a new page or a user page to the Private Pages
L+ 7 area, right-click Private Pages, select the option or
Add select a module, click the icon and select:

» New Page to add a blank page. For details, see
“Edit Page Dialog Box” on page 124.

» New Group to add a group. For details, see “Edit
Group Dialog Box” on page 123.

» Add Preconfigured Page to add a user page. For
details, see “Add Preconfigured Pages Dialog Box”
on page 103.

Click to return to the Create Module page.

Back
= To copy a page, right-click the page and select the
option or select the page in the tree and click the
button.
Copy

To copy a portlet, right-click the portlet and select the
option or select the page in the tree and click the
button.
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GUI Element Description

To delete a page in the tree, right-click the page and
X select Delete, or select the page, and click the button.

You must also confirm the deletion.

Delete
To delete a portlet in the tree, right-click the portlet
and select Delete, or select the portlet, and click the
button. You must also confirm the deletion.

Edit To edit a page, right-click the page and select the

option. For details, see “Edit Page Dialog Box” on
page 124. You can then add portlets to the page or
delete them from the page.To edit a portlet, right-click
the portlet and select the option. For details, see “Edit
Preferences <portlet_name> Dialog Box” on page 127.

Paste

After you select a page and copy it, right-click Private
Pages and select Paste, or click Private Pages, and click
the button.

After you select a portlet and copy it, right-click the
page where you want to paste it and select Paste, or
click the page where you want to paste the portlet, and
click the button.

To reorder the pages in the Private Pages area, right-
click the page and select Up or Down, or select a page
in the module, and use the Up and Down buttons.

You can also rearrange the modules in the Shared Pages
area; this change affects only the modules in your
Shared Pages area.

View

To display a preview of the page with real data, right-
click the page and select View or select a page and click
the button.

To display a preview of the portlet with real data, right-
click the portlet and select View or select a portlet and
click the button.
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Edit Page Area

The area includes the following elements (listed alphabetically):

GUI Element Description

<portlets> Each portlet in the page is represented by a box. For
more details, see “My BAC Page” on page 146.

Note: If the user does not have the appropriate
permissions to view the portlet, an error message is
displayed inside the portlet box.

Add Portlets Click to add portlets to the page. For details, see “Add
Portlets to <page_name>/Add Portlets Dialog Box” on
page 102.

Page Name Enter the name of the page.

Preview Click to preview the page. The page is displayed with
real data.

Edit Preferences <portlet_name> Dialog Box

Description Enables you to edit a portlet.

To Access: Click the Edit button in the portlet frame.

Important The page displays different elements depending on the
Information selected portlet. For details, see below.
Included in Tasks “Edit/Customize a Portlet” on page 26

“Manage the Portlets in Your Portal” on page 28
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The page includes the following elements (listed alphabetically):

GUI Element

Description

<areas>

The areas displayed in the page depend on the selected
portlet. The areas are (listed alphabetically):
“Advanced Settings Area” on page 128

“Filter Area” on page 129

“KPI Selection Area” on page 129

“Options Area” on page 130

“RSS Area” on page 131

“View Selection Area” on page 132

YYYVYYVYY

Change Title

Click to change the title of the portlet.

Preview

Click to display a preview of the portlet with real data.

Advanced Settings Area

The area includes a subset of the following elements:

GUI Element

Description

Breakdown with pie
chart

Select to display the portlet information in pie chart
format.

Breakdown with pie
chart and table

Select to display the portlet information in pie chart
and table formats.

Breakdown with
table

Select to display the portlet information in table
format.

Graph

Select to display the portlet information in graph
format.

Refresh rate

Choose how often to update the report: never (No
Refresh), hourly (1 Hour), or every two hours (2 Hours).

Show only the
selected subtree

Select the check box to display the CI and its subtree.
Clear the check box to display all CIs included in the
view. The selected CI is marked.

Table

Select to display the portlet information in table
format.
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Filter Area

Important The Filter area is displayed for some of the portlets. It
Information includes different elements depending on the portlet.

When editing the Service Report portlet, click Launch
Service Report Builder to open the Service Report
Builder wizard. For details, see “Service Report Builder
Wizard” on page 154.

KPI Selection Area

The area includes the following elements (listed alphabetically):

GUI Element Description

Business A star in the column indicates that the corresponding
KPI has been defined as a Business KPI or as a Business
and Operations KPI. For details, see “KPIs for User
Modes” in Using Dashboard.

KPI Use this area to select the KPIs you want to display in
the portlet. The listed KPIs correspond to the view and
the view’s CIs that you selected in the View Selection
area.

Operation A star in the column indicates that the corresponding
KPI has been defined as an Operations KPI or as a
Business and Operations KPI. For details, see “KPIs for
User Modes” in Using Dashboard.
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Options Area

The area includes the following elements (listed alphabetically):

Preference

Description

Active Filters

Displayed for the Filters portlet.

Select from the list to create filters that filter ClIs, to
focus on a specific view, on specific CI types or statuses,
or on problematic areas. For an explanation of the
filters, see “Defining/Editing Filters Dialog Box” in
Using Dashboard.

Map Style

Choose the style of the map to be displayed. For
details, see “Geographical Map Page” in Using
Dashboard.

Play Status Alert
Sound

When selected, a sound alert is played when the portlet
is currently displayed and a CI's KPI changes status to
Critical (red). The Critical status icon flashes until the
next screen refresh.

Note:

» If a Cl in a hidden part of the view changes to
Critical but does not change the status of any of the
CIs in the currently displayed branches, no sound is
played.

» The first time a view loads, no sound is played for
the CI’s KPIs that are loaded at Critical status.

The alert sound is a .wav file downloaded by the
browser.

Note: If you are using Mozilla, you must download a
plug-in for playing .wav files.

For details, see “Change the Status Alert Sound” on
page 62.
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Preference Description
Show When selected, My BAC displays the acknowledgement
Acknowledgement icon in the portlet. For details, see “Acknowledge

Performance Problems” in Using Dashboard.

Show only the Displayed for the Top View portlet.

selected subtree Select the check box to display the CI and its subtree.
Clear the check box to display all CIs included in the
view. The selected CI is marked.

RSS Area

The area includes the following elements (listed alphabetically):

GUI Element Description

Host Enter the name of the proxy or gateway server.

Maximum number of | Enter the number of items in an RSS feed to display in
items to display the portlet. For example, 5 means that My BAC
displays the first 5 entries in a feed from a particular
source. If you leave this field empty, My BAC displays
all items in a feed.

Port Enter the number of the port used by the proxy or
gateway server to receive requests.
Default: 80

Protocol Enter the protocol used to send requests to the proxy

or gateway server.

Default: http

Refresh rate Select the refresh rate, in minutes, from the list.

Select No Refresh if you want to manually refresh the

RSS feed display.

RSS URL Enter the full URL that returns an XML file in RSS
format.

Use proxy Select to specify the proxy or gateway server used to

access the RSS feed.
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View Selection Area

The area includes the following elements (listed alphabetically):

GUI Element

Description

<view explorer>

This pane displays View Explorer. Select the view and
the CIs on which you want to focus the portlet. For
details about View Explorer, see “View Explorer” in
Reference Information.

Export My BAC Objects Dialog Box

132

Description

Enables you to export portlet definitions or modules.
You save the resulting XML file and import it into
another HP Business Availability Center instance. You
would probably export a portlet definition or module
when upgrading the HP Business Availability Center
version, or when moving data from a test to a
production environment. For details on importing
portlet definitions or modules, see “Import Portlets and
Modules” on page 20.

To Access: Select Admin > My BAC > Manage Portlet
Definitions > Export Objects.

Important
Information

You can export one or more portlets and one or more
modules in one file, or you can export each portlet or
module in its own file.

Included in Tasks

“Export Portlets and Modules” on page 31
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The dialog box includes the following elements (listed alphabetically):

GUI Element

Description

o

Click the icon near the Export Portlet Definitions box
and select the portlets to be exported. If you select
several portlets, they are exported together in one file.

Click the Export Modules box to choose the modules
to be exported and select the modules to be exported.
If you select several modules, they are exported
together in one file.

Note: You can select to export both portlets and
modules in one file.

Export

Click to open the XML file corresponding to the
selected object, select all the lines in the file, and copy
them to an external application. In the page that
opens, click:

» Open to display the XML file in the Web browser
(not recommended).

» Save to open the Save As dialog box. Navigate to the
folder in which you want to save the file, enter a
name for the file or accept the default name, and
click Save. The selected portlet definitions and
modules are exported to an XML file in the location
you chose.

» Cancel to return to the Export My BAC Objects page
without saving the file.

Export Modules

Enter the name of the module.

Export Portlet
Definitions

Enter the name of the portlet definition.
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Import My BAC Objects Dialog Box

Description

Enables you to import portlet definitions and modules.
You would probably import a portlet definition or
module when upgrading the HP Business Availability
Center version, or when moving data from a test to a
production environment.

To Access: Select Admin > My BAC > Manage Portlet
Definitions > Import Objects.

Included in Tasks

“Import Portlets and Modules” on page 20

The dialog box includes the following elements (listed alphabetically):

GUI Element Description

Browse Click to locate the folder where the XML file is located.
Select the file and click Open to return to the Import
My BAC Obijects page.

Import Click to import the selected object.

My BAC displays a window with the import status for
the portlet definitions and modules in the XML file.

Import from File

Enter the name of the file.

Replace same
Modules

Select to replace a module with the data in the XML
file.

Note: If both check boxes are cleared, My BAC skips
any portlet definitions or modules in the file, whose ID
(for example, <uuid>) is the same as in My BAC.

Replace same Portlet
Definitions

Select to replace a portlet definition by the imported
one.

Note: If both check boxes are cleared, My BAC skips
any portlet definitions or modules in the file, whose ID
(for example, <uuid>) is the same as in My BAC.
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Description Enables you to import a portlet definition to make it
available to be added to a page in My BAC.

To Access: Select Admin > My BAC > Manage Portlet
Definitions > Import Portlet Definition.

Important Only one portlet can be selected at a time.
Information

Included in Tasks “Import Portlet Definitions” on page 19
Wizard Map Import Portlet Definition Wizard:

Choosing Portlet Type Page > Define Producer Web
Service Page > Select from Available Portlets Page >
Enter Portlet Information Page > Configure Access Page
> Confirm a Successful Import Page

Choosing Portlet Type Page

Description Enables you to select the type of portlet you want to
import.

Important For important information, see “Import Portlet

Information Definition Wizard” on page 135.

Wizard Map Import Portlet Definition Wizard:

Choosing Portlet Type Page > Define Producer Web
Service Page > Select from Available Portlets Page >
Enter Portlet Information Page > Configure Access Page
> Confirm a Successful Import Page
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The page includes the following elements (listed alphabetically):

GUI Element Description

Java Portlet Select the type of portlet you want to importing: Java

WSRP Portlet or WSRP. For details, see “Java and WSRP Portlets” on
page 16.

Next Click to open the next wizard page. For details, see

“Select from Available Portlets Page” on page 137 if you
have selected Java Portlet or see “Define Producer Web
Service Page” on page 136 if you have selected WSRP
Portlet.

Define Producer Web Service Page

Description Enables you to enter the WSRP Producer URL from
which you want to import portlets.

Important For important information, see “Import Portlet

Information Definition Wizard” on page 135.

Wizard Map Import Portlet Definition Wizard:

Choosing Portlet Type Page > Define Producer Web
Service Page > Select from Available Portlets Page >
Enter Portlet Information Page > Configure Access Page
> Confirm a Successful Import Page
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The page includes the following elements (listed alphabetically):

GUI Element

Description

Next

Click to open the next wizard page. For details, see
“Select from Available Portlets Page” on page 137.

WSRP Producer URL

Enter the URL of a Web service that provides portlets
via the WSRP protocol. If your consumer is:

» Another My BAC user. Enter a URL with the
following format:
http://<server_name>/dashboard/wsrp4jproducer.
wsdl

» An external portal. Enter the appropriate URL.

My BAC contacts the Web service to determine which
portlets are available and displays them in the next
page.

Note: If you import a portlet from another My BAC
machine, you can use a URL that includes the
authentication information. For details, see “Create
WSRP URL Dialog Box” on page 121.

Select from Available Portlets Page

Description

Enables you to select the portlet to be imported. To
Access:

» Select Java Portlet in the Choose Portlet Type page
and click Next.

» Click Next in the Define Producer Web Service page.

Important
Information

In the Select from Available Portlets page, only one
portlet can be selected at a time.

For important information, see “Import Portlet
Definition Wizard” on page 135.

Wizard Map

Import Portlet Definition Wizard:

Choosing Portlet Type Page > Define Producer Web
Service Page > Select from Available Portlets Page >
Enter Portlet Information Page > Configure Access Page
> Confirm a Successful Import Page
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The page includes the following elements (listed alphabetically):

GUI Element Description

<Java Portlet> Select a Java portlet.

A red check mark next to a portlet signifies that it has
been imported previously.

For details, see “Java and WSRP Portlets” on page 16.

Finish Click to perform other actions, such as importing
another portlet definition. For details, see “Confirm a
Successful Import Page” on page 143.

Next Click to open the next wizard page.

Enter Portlet Information Page
The page includes the following elements (listed alphabetically):

Description Enables you to change the portlet information such as
the name or category.

Important For important information, see “Import Portlet
Information Definition Wizard” on page 135.
Wizard Map Import Portlet Definition Wizard:

Choosing Portlet Type Page > Define Producer Web
Service Page > Select from Available Portlets Page >
Enter Portlet Information Page > Configure Access
Page > Confirm a Successful Import Page
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The area includes the following elements (listed alphabetically):

GUI Element Description

Category Select one or more categories that characterize the
portlet. A category helps users find the portlets they
need. Click the Manage Categories button to add or
delete portlet categories. For details, see “Manage
Categories Dialog Box” on page 143.

Default Width Select Wide or Narrow default portlet width. System
default is Narrow.

Description To aid users, enter a description of the portlet. The
maximum length of the description is 1800 characters.

Enabled Choose Yes (default) to enable the portlet to be added
to a page. (You would probably choose No in a testing
environment.)

Finish Click to perform other actions, such as importing
another portlet definition. For details, see “Confirm a
Successful Import Page” on page 143.

Name Enter a new name for the portlet.

Note: The name of the portlet must be unique. The
maximum length of the name is 80 characters. This
field is mandatory.

Next Click to open the next wizard page. For details, see
“Configure Access Page” on page 140.

If a portlet definition with the name already exists,
My BAC displays a message. Return to the Import
Portlet Definition page and change the name.
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Configure Access Page

Description Enables you to configure access rights to the portlet for
users, groups of users, and administrators.

Note: Access to a portlet definition is given, by default,
to all users and all administrators. If you assign access
rights to specific users or groups of users, or to specific
administrators, My BAC removes the All Users or All
Portlet Definition Administrators type from the list and
replaces the type with the user, group of users, or
administrator you selected.

Important In this page, decide whether users need a special
Information license to access the portlet.

Note: To configure a portlet definition, the user must
have the permission to configure a portlet definition.
Select Platform > Admin > Users and Permissions, select
the My BAC context, select Portlet Definitions, and
assign the permissions.

For important information, see “Import Portlet
Definition Wizard” on page 135.

Wizard Map Import Portlet Definition Wizard:

Choosing Portlet Type Page > Define Producer Web
Service Page > Select from Available Portlets Page >
Enter Portlet Information Page > Configure Access
Page > Confirm a Successful Import Page
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User Access Area

Description Enables you to select the users or groups who can add
the portlet to their private My BAC dashboard.

The area includes the following elements (listed alphabetically):

GUI Element Description

Click the icon near the Require users to have one of

o .. .
- these privileges box to choose a privilege.

Click the icon near the Give Access to box to choose
the groups with read-only access to the module.

For details, see “Users or Groups Dialog Box” on
page 151.

ﬂ Click to choose the users with read-only access to the
module. For details, see “Users or Groups Dialog Box”
on page 151.

Give Access to Select User or Group.

Note: You must select at least one user or one group.

Name The name of the selected user or group of users.

Require users to have | Enter the name of the application for which you have a
one of these license.

privileges Note: A user without the correct license for the
application on which the portlet is based, cannot
access the portlet.

Type Displays the type (users or groups of users).
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Administrator Access Area

Description

Enables you to select the users or groups who can
modify the portlet definition and can also add the
portlet to their private pages.

The area includes the following elements (listed alphabetically):

GUI Element

Description

&)

Click to choose the users with read-only access to the
module. For details, see “Users or Groups Dialog Box”
on page 151.

Note: You must select at least one user or one group.

Click to choose the groups with read-only access to the
module. For details, see “Users or Groups Dialog Box”
on page 151.

Note: You must select at least one user or one group.

Give Access to

Select User or Group.

Note: You must select at least one user or one group.

Name

The name of the selected user or group of users.

Type

Displays the type (users or groups of users).

Make Portlet avail

able to WSRP Consumers

Description

Enables you to make the WSRP portlet available for

Web service clients.

The area includes the following elements (listed alphabetically):

GUI Element

Description

Make Portlet
available to WSRP
Consumers

Select to make the WSRP portlet available for Web
service clients.




Chapter 3 « My BAC User Interface

Confirm a Successful Import Page

Description The last stage of the procedure is to confirm that the
portlet has been successfully imported. My BAC
displays a message confirming a successful import.

Important For important information, see “Import Portlet
Information Definition Wizard” on page 135.
Wizard Map Import Portlet Definition Wizard:

Choosing Portlet Type Page > Define Producer Web
Service Page > Select from Available Portlets Page >
Enter Portlet Information Page > Configure Access Page
> Confirm a Successful Import Page

Manage Categories Dialog Box

Description During the procedures for importing or configuring a
portlet definition, you can select portlet categories that
enable users to more easily find a specific portlet to add
to their portal. My BAC categories include the

HP Business Availability Center applications such as
Service Level Management, Dashboard, and End User
Management. You can add categories to the list.

To Access: In the Import Portlet Definitions or
Configure Portlet Definitions page, click the Manage
Categories button to open the Manage Categories

page.

Included in Tasks “Manage Portlet Categories” on page 20

The page includes the following elements (listed alphabetically):

GUI Element Description

ﬁ Click to delete the appropriate user-defined category.

Note: You cannot delete built-in categories: Dashboard,
General, CMDB, End User Management, and SLM.

New Category Enter the name of a new category and click Add.
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Manage Modules Tab
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Description

Enables you to manage modules.

To Access: Select Admin > My BAC, and click the
Manage Modules tab.

The page includes the following elements (listed alphabetically):

GUI Element

Description

?

Click to open the component online help.

Configure Modules

Enables you to edit existing modules. For example, add
or delete pages and portlets from a module, set user
access rights to modules, or copy and delete modules.
Click to open the Configure Modules dialog box.

Create Module

Enables you to create modules that you publish or
distribute to users. A module is a collection of pages in
a portal that can be viewed by users when they access
their My BAC portal. Click to open the Create Module
dialog box.
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Manage Portlet Definitions Tab

Description

Enables you to Configure portlets.

To Access: Select Admin > My BAC, and click the
Manage Portlet Definitions tab.

The page includes the following elements (listed alphabetically):

GUI Element

Description

?

Click to open the component online help.

Configure Portlet
Definition

Enables you to edit, copy, or delete portlet definitions.

Click to open the Configure Portlet Definitions dialog
box.

Create WSRP URL

Enables you to create a WSRP URL when you want to
export portlets from My BAC to a remote portal.

Click to open the Create WSRP URL dialog box.

Export Portlets and
Modules

Enables you to export portlet definitions and modules
for importing into another HP Business Availability
Center instance.

Click to open the Export My BAC Objects dialog box.

Import Portlet
Definition

Enables you to import portlet definitions so that the
portlets are available for inclusion in a page.

Click to open the Import Portlet Definition dialog box.

Import Portlets and
Modules

Enables you to import portlet definitions and modules,
for example, when moving data from a test to a
production environment.

Click to open the Import My BAC Obijects dialog box.
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My BAC Page

Description Displays the pages set up for you by the Administrator.
Enables you to personalize pages, or to add new pages
and portlets.
To Access: Select My BAC.

Important If a portlet contains no data, My BAC displays the

Information portlet’s title bar only.
You can set the cursor on a portlet’s title bar and drag
and drop the portlet in another location on the page.

Included in Tasks “Add Pages to Your Portal” on page 27
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The page includes the following elements (listed alphabetically):

GUI Element

Description

I [N

Click to display the previous page or the next page.

Switch to page... *

Click the button, and select a page or a portlet to
display in the menu that opens.

Note: If you have not yet viewed the page, an orange
box appears next to its name.

An orange box in the Switch to page menu indicates a
page or a portlet that you have not yet viewed since its
creation or since a change has been made to its
definition.

If a portlet definition has changed, the pages that
include the portlet are also assigned the orange box.

Note: The symbol disappears as soon as you open the
page.

A check mark indicates the current page in the Switch
to page menu.
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GUI Element Description

Click to view the My BAC administrator’s comments
for the module in the <module-name> Module
Comments page.

The administrator uses the module comments to
inform users of changes to pages or portlets in the
module.

Click to open the Page Rotation dialog box, where you
can specify the rotation time and if you want the pages
to be displayed in pop-up mode. For details, see “Page
Rotation Dialog Box” on page 149.

Click to personalize your My BAC portal. For details,
E see “Edit Page Dialog Box” on page 124.

@ Click to stop the rotation. For details, see above.

Shared Page Indicates that the administrator has set the page’s
access status to Allow access to all users but did not set
Enable users to copy this module pages to their private
dashboard. For details, see “Configure Modules Dialog
Box” on page 105.

Stop Appears in a page that is rotating.
Click to stop the rotation.

Portlet Frame

Each portlet frame includes the following elements (listed alphabetically):

GUI Elements Description
ﬂ Click to display help about a specific portlet.
Click to edit the portlet preferences. The portlet
[ preferences are configured in HP Business Availability
Center. For details on a particular portlet’s preferences,
see “Portlet Categories” on page 44.
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GUI Elements

Description

Click to maximize the portlet, so that My BAC displays
the portlet across the two columns.

Click to minimize the portlet, so that only the portlet’s
title bar is displayed. Click the button again to
redisplay the portlet.

Move the mouse over the button to display the filters

L defined for the HP Business Availability Center report.

" Indicates that the trend of the calculated measurement
is up. For details, see “New Measurement Dialog Box”
on page 164.

v Indicates that the trend of the calculated measurement
is down. For details, see “New Measurement Dialog
Box” on page 164.

- Indicates that the trend of the calculated measurement

is the same (no change). For details, see “New
Measurement Dialog Box” on page 164.

<context menu

In some of the portlets, use the context menu options

options> to access other reports. For details on the context menu
options in Dashboard portlets, see “Dashboard Menu
Options” or “Top View Menu Options” (for the Top
View portlet) in Using Dashboard.

Back Click to return the portlet to its original size (across

one column) after you have maximized it.
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Page Rotation Dialog Box

Description

Enables you to specify the rotation rate of the pages in
your My BAC application, and whether you want to
display the pages in popup mode. Click to open the
Page Rotation dialog box.

=
To Access: In My BAC page, click @

Important
Information

A page that is rotated is automatically refreshed before
it is displayed and not refreshed during the period of
time it is displayed.

Included in Tasks

“Personalize Your My BAC Portal” on page 27

The dialog box includes the following elements (listed alphabetically):

GUI Element Description

Full Screen Optionally, select Full screen to display each page of
My BAC in a pop-up page.

Interval Enter the page rotation time. For example, if you enter
15 seconds, each page defined in My BAC is displayed,
one after the other, every 15 seconds.
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Portlet Privilege Dialog Box
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Description Enables you to select the applications for which you
have a license.
To Access: In the pages and dialog boxes of My BAC,
click the privilege button E

Important For details on defining privileges, see “User

Information Management Overview” in Platform Administration.

The dialog box includes the following elements (listed alphabetically):

GUI Element

Description

Available/Selected

Move privileges from the Available area to the Selected
area to select them.

Change Order

Click to change the order of the privileges in the
Selected area.

Find

Enter the first letters of the privilege name and click
the button to display all the privileges whose name
starts with those letters.

Privilege name starts
with

Enter the name of the application, or the first letters of
the application name for which you have a license and
click Find.
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Users or Groups Dialog Box

Description Enables you to select users or groups.

To Access: In the pages and dialog boxes of My BAC,
click:

» The users button ﬂ

> The groups button |

Important For details on defining users and groups, see “User
Information Management” in Platform Administration.

The dialog box includes the following elements (listed alphabetically):

GUI Element Description

Available/Selected Move users or groups from the Available area to the
Selected area to select them.

Change Order Click to change the order of the users or groups in the
Selected area.

Find Enter the first letters of a user or group of users name
and click the button to display all the users or groups
whose name starts with those letters.

Show All Click to display a list of all the available users or
groups.
User Enter the name of the user or the first letters of the user

or group of users name and click Find.
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Service Report User Interface

This chapter describes the pages and dialog boxes that are part of the Service
Report user interface, listed alphabetically.

This chapter describes: On page:
Service Report Builder Wizard 154
New Measurement Dialog Box 164
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Service Report Builder Wizard

Description

Enables you to select a data source on which you want
to base the Service Report, to select the dimensions and
measurements that are to appear in the report, and to
specify the structure of the report.

To Access:

» In My BAC, click the Click here button in the Filter
area of the Edit Preferences page of a Service Report
portlet.

» In Custom Report Manager, click the Edit button

ﬁT corresponding to the Service Report
component.

Included in Tasks

“Configure a Service Report” on page 75

Wizard Map

Service Report Builder Wizard includes: Welcome >
Select a Data Source Page > Select Dimensions Page >
Select Measurements Page > Select the Dimension
Filters > Summary Page

Select a Data Source Page

Description

Enables you to select one or more data sources on
which you want to base the Service Report.

Important
Information

You can select more than one data source.

You cannot select the Service Level Management - SLA
Components Data and the Service Level Management -
SLA Data together.

For details on the impact of the data source selection,
see “Dimensions and Measurements” on page 64.

Wizard Map

Service Report Builder Wizard includes: Welcome >
Select a Data Source Page > Select Dimensions Page >
Select Measurements Page > Select the Dimension
Filters > Summary Page
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The page includes the following elements (listed alphabetically):

GUI Element Description

Dashboard KPIs data | To build the report using data for business-related CIs,
based on historical data from the associated Dashboard
KPIs.

Over Time Additional | To build the report using data such as Number of
data tickets and Number of measurements, for CIs and Time
range dimensions, from multiple data sources.

Service Level To build the report using the CIs, KPIs, SLAs, Time and
Management - SLA Time Interval dimensions, and the Value, Status,

KPI data Additional Values, and Objective measurements.
Service Level To build the report using the SLAs, Tracking Period,
Management - SLA and Time dimensions, and the SLA Status for Previous
Status data Periods, SLA Current Status, and SLA Current Status By

Time Periods, and SLA Forecast measurements.

Select Dimensions Page

Description Use the Dimensions Selection page to select the
dimensions you want to display in the report and
whether they are to appear as a column or a row.

Important See limitations in “Troubleshooting and Limitations”
Information on page 96.

Before using this page, see “Tips and Tricks” on

page 72.
Wizard Map Service Report Builder Wizard includes: Welcome >

Select a Data Source Page > Select Dimensions Page >
Select Measurements Page > Select the Dimension
Filters > Summary Page
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The page includes the following elements (listed alphabetically):

GUI Element

Description

Select a dimension in the Available dimensions area
and click the forward arrow to move the dimension to
the Columns or Rows area.

Select a dimension in the Row or Column area and
click the arrow to move the dimension back to the
Available dimensions area.

Change the order of the dimensions in the Columns or
Rows area by clicking the up and down arrows. By
default, the dimensions are listed in alphabetical order.

Available Dimensions

Select the appropriate dimension and select where you
want to put it in the report by clicking the forward
arrow to the Columns or Rows area.

Use the following guidelines to select the dimensions:

» If you select only one dimension and move it to the
Rows (Columns) area, the dimension’s
measurements appear as columns (rows) in the
Service Report.

» If you select more than two dimensions, there is no
restriction to the location of the dimensions.

Clear

Click to clear all the selections on the page.
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GUI Element

Description

Enable automatic
preview

You can display a preview of the report by selecting
Enable automatic preview. When you edit an existing
Service Report, Enable automatic preview is
automatically selected and the Preview button is
dimmed. Each change made to the top part of the page
automatically generates the preview report.

Note: If, after previewing the page, you clear Enable
automatic preview, the automatic preview is disabled
on the next wizard page.

Preview

Click to review the page. The preview shows the report
structure with the column and row headers; it does not
display data.

When you edit an existing Service Report, Enable
automatic preview is automatically selected and the
Preview button is dimmed. Each change made to the
top part of the page automatically generates the
preview report.

Note: The preview report displays randomly generated
data and background color for illustration purposes
only, and two placeholder values for each selected
dimension.
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Select Measurements Page

Description Use the Measurements Selection page to select the
measurements you want to display in the report and
whether they should appear as rows or columns.

The measurements that are listed in the Available
Measurements area depend on the dimensions you
selected in the Dimensions Selection page. For details,
see “Dimensions and Measurements” on page 64.

Important You must select at least one measurement.

Information The dimensions and measurements of each application

are mapped differently. For details, see “Dimensions
and Measurements” on page 64 or “Select the
Dimension Filters” on page 161.

See limitations in “Troubleshooting and Limitations”
on page 96.

Before using this page, see “Tips and Tricks” on
page 72.

Wizard Map Service Report Builder Wizard includes: Welcome >
Select a Data Source Page > Select Dimensions Page >
Select Measurements Page > Select the Dimension
Filters > Summary Page

The page includes the following elements (listed alphabetically):

GUI Element Description
- Select a measurement in the Available Measurements
J area to move the measurement to the Selected

Measurements area.

Select a measurement in the Selected Measurements
- area and click to move the measurement back to the
Available Measurements area.

P Click to create a customized measurement.
i

See limitations in “Troubleshooting and Limitations”
on page 96.
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GUI Element

Description

2

Select a customized measurement and click to edit.

2]~

Change the order of the measurements in the Selected
Measurements area by clicking the up and down
arrows. By default, the measurements are listed in
alphabetical order.

Available
Measurements

Select the appropriate measurement and click the
right arrow to move the measurement to the
Selected Measurements area.

Note: For some measurements (like Value, or Status),
select where you want the measurements to be
displayed in the report by selecting As column headers
or As row headers. For details, see “Dimensions and
Measurements” on page 64.

Clear

Click to clear all the selections on the page.

Enable automatic
preview

You can display a preview of the report by selecting
Enable automatic preview. When you edit an existing
Service Report, Enable automatic preview is
automatically selected and the Preview button is
dimmed. Each change made to the top part of the page
automatically generates the preview report.

Note: If, after previewing the page, you clear Enable
automatic preview, the automatic preview is disabled
on the next wizard page.
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GUI Element Description

Preview Click to review the page. The preview shows the report
structure with the column and row headers; it does not
display data.

When you edit an existing Service Report, Enable
automatic preview is automatically selected and the
Preview button is dimmed. Each change made to the
top part of the page automatically generates the
preview report.

Note: The preview report displays randomly generated
data and background color for illustration purposes
only, and two placeholder values for each selected
dimension and measurement.
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Select the Dimension Filters

Description Use the Dimensions Filter page to filter the dimensions
you want to display in the report.

Important The Available Dimensions area lists:

Information » The dimensions you selected in the Dimensions

Selection page

» The dimensions related to the measurements you
selected in the Measurement Selection page
according to the application’s dimensions and
measurements map.

For details, see “Dimensions and Measurements” on
page 64.

You must select the relevant dimension filters for each
dimension listed in the Available Dimension Filters
area.

The type of link between dimensions and
measurements has an influence on the type of
selection you can perform:

You must select at least one measurement.

The dimensions and measurements of each application
are mapped differently. For details, see “Dimensions
and Measurements” on page 64.

See limitations in “Troubleshooting and Limitations”
on page 96.

Before using this page, see “Tips and Tricks” on
page 72.

Wizard Map Service Report Builder Wizard includes: Welcome >
Select a Data Source Page > Select Dimensions Page >
Select Measurements Page > Select the Dimension
Filters > Summary Page

161



Chapter 4  Service Report User Interface

162

The page includes the following elements (listed alphabetically):

GUI Element

Description

Available Dimensions
Filters

Select a dimension in the list.

Clear

Click to clear all selections.

Dimensions Filter

Select the required dimension filter.

Select only two values for dimensions that are used as a
base for calculated functions. If you select one, or more
than two values, an error message is displayed.

For additional information, see “Impact on the Type of
Selection: Single Selection or Multiple Selection” on
page 66.

Enable automatic
preview

You can display a preview of the report by selecting
Enable automatic preview. When you edit an existing
Service Report, Enable automatic preview is
automatically selected and the Preview button is
dimmed. Each change made to the top part of the page
automatically generates the preview report.

Note: If, after previewing the page, you clear Enable
automatic preview, the automatic preview is disabled
on the next wizard page.

Preview

Click to review the page. The preview shows the report
structure with the column and row headers; it does not
display data.

When you edit an existing Service Report, Enable
automatic preview is automatically selected and the
Preview button is dimmed. Each change made to the
top part of the page automatically generates the
preview report.

Note: The preview report displays randomly generated
data and background color for illustration purposes
only, and two placeholder values for each selected
dimension.
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Summary Page

Description The Summary page displays the report you have
created with real data and real background color.

Important For more information, see “Edit Preferences

Information <portlet_name> Dialog Box” on page 127.

Wizard Map Service Report Builder Wizard includes: Welcome >

Select a Data Source Page > Select Dimensions Page >
Select Measurements Page > Select the Dimension
Filters > Summary Page

The page includes the following elements (listed alphabetically):

GUI Element Description
Remove empty Select to remove, from the report, the columns and
columns and rows rows that do not have data.

from report
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New Measurement Dialog Box

164

Description

Enables you to add a calculated or aggregated
measurement based on the measurements you selected
in the Select Measurements page.

To Access: Click New Measurement in the Select
Measurements page in the Service Report Builder
wizard.

Important
Information

After you create a new measurement, you are returned
to the Select Measurements page where the new
measurement is automatically moved to the Select
Measurements box.

Any selection performed before creating a new
measurement is discarded when you are returned to
the Select Measurements box unless you validated the
selection (by clicking the Next or Back button) before
creating the new measurement.

If you want to delete a measurement you created, move
it back to the Available Measurements box. When you
click Finish, the new measurements located in the
Available Measurements box are automatically deleted
(they are not in use).

See limitations in “Troubleshooting and Limitations”
on page 96.

Included in Tasks

“Configure a Service Report” on page 75

“Create a Customized Measurement” on page 82

Useful Links

“Naming Conventions” in Reference Information
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The dialog box includes the following elements (listed alphabetically):

GUI Element

Description

Measurement name

The name of the measurement you are creating.

Note: * indicates that the field is compulsory.

Measurement
description

The description of the measurement you are creating.

Note: The description of the measurement appears as a
tooltip when you move the mouse over the
measurement in the Select Measurements page.

Measurement type

Select one of the following:

» Calculated to use a calculated function.
» Aggregated to use an aggregated function.

Select function

Select the appropriate function. For details, see
“Calculated Functions” on page 165 or “Aggregated
Functions” on page 166.

Calculated Functions

The calculated functions are as follows (listed alphabetically):

Function

Description

Difference

Returns the difference between the measurements
selected in the First measurement list and the Second
measurement list.

Difference by
percentage

Returns the difference between the measurements
selected in the First measurement list and the Second
measurement list, divided by the measurement
selected in the Second measurement list, and
multiplied by 100 (the result is in percentages).

Note: If the source measurement value is 0, and the
target value is not O, the function cannot calculate the
difference, and the calculation result is “-“. For
example: the difference by percentage of 97 from O is

“.n
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Function

Description

Status

Compares the value of the measurement selected in
Compare measurement box with the specified
thresholds and returns a color. For more details, see
“Status Function Automatic Measurements” on
page 71.

Trend

Returns the trend between the measurements selected
in the First measurement list and the Second
measurement list. The trend is indicated in the final
report, using up 4. , down ¥ , or no change arrow
< . For details, see “My BAC Page” on page 146.

Aggregated Functions

The aggregated functions are as follows (listed alphabetically):

Function Description

Average Returns the average of the values of the measurement
you select in the Select measurement list.

Max Returns the highest value of the measurement you
select in the Select measurement list.

Min Returns the lowest value of the measurement you select
in the Select measurement list.

Sum Returns the sum of the values of the measurement you
select in the Select measurement list.

Best Available only for status measurement types. Returns
the best status of all the selected measurement statuses.

Worst Available only for status measurement types. Returns
the worst status of all the selected measurement
statuses.

166




Chapter 4 « Service Report User Interface

Function

Description

Count Status

Available only for status measurement types. Returns
the number of times the status has the value selected in
the Select measurement instance during the selected
period of time.

Status Percentage

Available only for status measurement types. Returns
the percentage of the status with the value selected in
the Select measurement instance.

Function Parameters

The function parameters are as follows (listed alphabetically):

GUI Element Description
Compare Displayed when you create a Status calculated
measurement function.

Select the measurement you want to compare with the
thresholds you specify in To Threshold.

Create measurement

Displayed when you create a Status calculated
function.

Select one of the measurements that is automatically
created when you create a Status calculated function.
For details about those measurements, see “Status
Function Automatic Measurements” on page 71.
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GUI Element Description

First measurement Displayed when you create a calculated function.

Select the first measurement to be used in the
calculation.

Note: When you create a calculated measurement, the
names of the measurement in the First measurement
and Second measurement lists are followed by an
expression between parenthesis. For example, Event
Count (Status 1) represents the instance of the
measurement in the report. When the report including
real data is displayed, the calculation occurs between
the first instance of the measurement and the second
instance of the measurement (or vice versa) according
to your selection.

You can perform calculations between:

» Two different instances of the same measurement.
You can select only two instances (values) of the
dimension on which you base the calculation in the
Select Dimensions Filter page.

» Different measurements. There is no limitation in
the number of instances.

Note: When you select to display a dimension in a
specific location (rows or columns), any calculated
measurement based on that dimension and other
selected measurements must also be displayed in the
same location.

Second Displayed when you create a calculated function.

measurement Select the second measurement to be used in the

calculation.

For more information, see “First measurement” on
page 168.

Select dimension Displayed when you create a calculated function.

Select the dimension on which you want to perform
the selected function.
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GUI Element

Description

Select measurement

Displayed when you create an aggregated function.

Select the measurement on which you want to perform
the selected function.

Selected
measurement
instance

Displayed when you create a Count Status or a Status
Percentage aggregated function.

Select: Failed, Breached, Minor Breached, Met,
Exceeded, No Data, or Downtime.

To thresholds

Displayed when you create a Status calculated
function.

Enter the threshold values and select the operator to
specify the status displayed when the comparison
between the value of the measurement you selected in
the Compare measurement list complies with the
thresholds.

Note: The threshold definitions depend on the data
source you selected in the Select a Data Source page.
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